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Welcome to This Guide

This guide describes how to use the HP SOA Systinet Customization Editor to edit the SDM configuration
and the user interface of an installation of SOA Systinet. Y ou can use the Customization Editor to modify
the model, its registry mappings and certain Ul elements.

How This Guide is Organized

This guide explains how to use the Customization Editor to create an extension to the configuration of HP
SOA Systinet, how to configure the individual elements of SOA Systinet and then deploy them to an
installation of SOA Systinet.

The guide explains:

Getting Started on page 11. Introducing and configuring the Customization Editor, its main features, and
the customizable elements of SOA Systinet.

Manipulating Artifact Types on page 31. Customizing the attributes, properties and appearance of artifacts.
Manipulating Properties on page 51. Creating and modifying properties and property groups.

Configuring the SOA Systinet Ul on page 63. Customizing the main tabs of SOA Systinet and creating new
Ul elements.

Creating and Using Components on page 79. Creating customi zed Javaand JSPs and using these components
with SOA Systinet.

Modifying Taxonomies on page 89. Modifying the set of available taxonomies.

Deploying an Extension to SOA Systinet on page 91. Preparing and deploying your extension to SOA
Systinet.

User Interface Reference on page 99. A guide to the Customization Editor user interface.



Document Conventions

The typographic conventions used in this document are;

run.bat make

Script name or other executable command plus mandatory arguments.

[--help]

A command-line option.

either | or

A choice of arguments.

repl ace_val ue

A command-line argument that should be replaced with an actual value.

{argl | arg2}

A choice between two command-line arguments where one or the other is
mandatory.

rmdir /S /Q SystenB2

Operating system commands and other user input that you can type on the
command line and press Enter to invoke. Itemsinitalics should be replaced
by actual values.

C:\ Systemi ni

Filenames, directory names, paths and package names.

a. append(b);

Program source code.

server. \Version

Aninline Java or C++ class name.

get Ver si on() Aninline Java method name.

Shift-N A combination of keystrokes.

Service View A label, word or phrase in a GUI window, often clickable.
New->Service Menu choice.

Documentation Updates

This manual's title page contains the foll owing identifying information:

e Software version number

» Document release date, which changes each time the document is updated

o Software release date, which indicates the release date of this version of the software

To check for recent updates, or to verify that you are using the most recent edition of a document, go to:




http://ovweb.exter nal.hp.com/Ipe/doc_serv/

Support

Mercury Product Support

Y ou can obtain support information for products formerly produced by Mercury as follows:

If you work with an HP Software Services Integrator (SVI) partner (http://h20230.www2.hp.-
com/svi_partner_list.jsp), contact your SV agent.

If you have an active HP Software support contract, visit the HP Software Support Web site and use
the Self-Solve Knowledge Search to find answers to technical questions.

For the latest information about support processes and tools available for products formerly produced
by Mercury, we encourage you to visit the Mercury Customer Support Web site at: http://hp.-
com/go/hpsoftwar esupport.

For the latest information about support processes and tools available for products formerly produced
by Systinet, we encourage you to visit the Systinet Online Support Web site at: http://www.systinet.-
com/support/index.

If you have additional questions, contact your HP Sales Representative.

HP Software Support

You can visit the HP Software Support Web site at:

http://ww.hp.com/go/hpsoftwar esupport

HP Software online support provides an efficient way to access interactive technical support tools. Asa
valued support customer, you can benefit by using the support site to:

Search for knowledge documents of interest
Submit and track support cases and enhancement requests

Download software patches


http://ovweb.external.hp.com/lpe/doc_serv/
http://h20230.www2.hp.com/svi_partner_list.jsp
http://h20230.www2.hp.com/svi_partner_list.jsp
http://hp.com/go/hpsoftwaresupport
http://hp.com/go/hpsoftwaresupport
http://www.systinet.com/support/index
http://www.systinet.com/support/index
http://www.hp.com/go/hpsoftwaresupport

* Manage support contracts

» Look up HP support contacts

* Review information about available services

» Enter into discussions with other software customers
* Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a
support contract. To find more information about access levels, go to: http://h20230.www2.hp.-
com/new_access levels.jsp

To register for an HP Passport ID, go to: http://h20229.www2.hp.com/passport-registration.html
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1 Getting Started

The Customization Editor is used to create extensions to the core SOA Systinet configuration. The core
configuration itself is not modified. Instead, SOA Systinet includes a utility for adding extensionsto the
configuration.

This chapter describes:

» Introduction to the Customization Editor on page 11 gives an overview of the use of the Customization
Editor.

*  Customizable Elements of SOA Systinet on page 12 describes the elements of SOA Systinet that are
configurable using the Customization Editor.

e Creating an Extension Project on page 17 describes how to start anew project to configure SOA Systinet.

e Introduction to the User Interface on page 19 explains the main features of the Customization Editor
user interface.

* Navigating the Customization Editor on page 21 describes the layout of the Extension Explorer —the
main navigation view in the editor.

e Customization Editor Menu Options on page 27 describes the Customization Editor optionsin the
Eclipse drop-down menus.

e Searching the Extension on page 28 explains how to use the search function to find elementsin the
extensions.

» Saving Modifications on page 29 describes how to save your modifications.

Introduction to the Customization Editor

SOA Systinet is distributed with a preconfigured data model and user interface. For typical deployment
scenarios, both need to be customized to fit an organization specific environment.

11



HP SOA Systinet Customization Editor provides a mechanism to customize both the model and the
appearance of the user interface, implement those changes and keep them isolated in a so-called extension
package that can then be re-applied during are-installation or upgrade of SOA Systinet.

The overall process of customizing SOA Systinet is as follows:
1 Usethe Customization Editor to:
e Modify the datamodel and user interface as described in;
* Manipulating Artifact Types on page 31
* Manipulating Properties on page 51
» Configuring the SOA Systinet Ul on page 63
» Creating and Using Components on page 79
» Maodifying Taxonomies on page 89

» Save your modifications to a stand-alone extension package file as described in Exporting the
Extension Project on page 91.

2 Usethe Setup Tool provided with SOA Systinet to apply the extension package to an installation of
SOA Systinet as described in Applying Extensions on page 92.

A Special care must be taken when modifying artifacts that already have instancesin the repository.
For example, anew installation already contains the person artifact administrator. Removing
properties from an artifact type with instances or adding anew required property without adefault
value may cause instability in SOA Systinet. The Customization Editor should prevent thisif the
SOA Systinet server is running during modification.

Customizable Elements of SOA Systinet

The Customization Editor enables you to modify almost any aspect of an installation of SOA Systinet.
These aspects consist of two main groups:

12 Chapter 1



SDM Entitiesarethe building blocksthat represent the types of entity that exist in the repository defined
by the SOA Definition Model. These are described in more detail in SDM Elements on page 13.

Ul Entities arethe elements of the SOA Systinet user interface. These are described in Ul Elementson
page 14.

SDM Elements

The Customization Editor deals with four types of entity in the SDM configuration of SOA Systinet:

Artifactsarethebasic building blocks of SOA. Every entity in the repository isan instance of an artifact.
Each type of artifact is defined by an artifact type in the SDM. Artifact types are further categorized
into artifact packages. These packages are abstract artifact types that do not have instances in the
repository but instead define groups of artifacts.

Artifact types and packages are visible in the Artifact Types branch of the Extension Explorer (see
Artifact Types on page 23) and artifact type procedures are described in Manipulating Artifact Types
on page 31.

Properties are the attributes of artifacts. Properties are the labels that distinguish one instance of an
artifact from another. For example, al artifact instances have the name property but every artifact has
adifferent name.

Propertiesarevisiblein the SDM Details branch of the Extension Explorer (see SDM Details on page
24) and property procedures are described in Manipulating Properties on page 51.

Property Groups enable properties to be organized and added to artifacts as a group instead of
individually. For example; name, address, and telephone number could be organized into a contact
details property group and then whenever a new artifact type is created that represents a person, the
group can be added to it instead of the individual properties.

Property Groups are visible in the SDM Details branch of the Extension Explorer (see SDM Details
on page 24) and property group procedures are described in Manipulating Properties on page 51.

Taxonomies are categorization groups that each contain a set of values within a single category. For
example, officelocation could be ataxonomic group containing a set of values representing each office
in an organization.

Getting Started 13



Taxonomiesarevisiblein the Taxonomies branch of the Extension Explorer (see Taxonomieson page
26) and taxonomy procedures are described in Modifying Taxonomies on page 89.

Ul Elements

Two types of SOA Systinet pages are configurable:
* Themain SOA Systinet tabs.

» Theartifact detail and browse pages.

The main SOA Systinet tabs consist of the tab heading, a menu on the left and a set of portletsin the main
area of the screen:

Figure 1. SOA Systinet Tab
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The two configurable elements on SOA Systinet tabs are:

Navigation Menu
The navigation menu is organized into navigation groups and actions.

Thedetailsfor each SOA Systinet tab are accessibleinthe User I nterface->Soa Systinet tab->Navigation
branch of the Extension Explorer (see User Interface on page 25).

All the navigation actionsin your extension are accessible in the User Interface->Ul Details-
>Navigation Actions branch in the Extension Explorer (see User Interface on page 25).

Configuring the navigation actions of a SOA Systinet tab, creating and modifying navigation actions,
and organizing navigation actionsinto groups are described in Configuring the SOA Systinet Ul on

page 63.
Portlets and Feeds

SOA Systinet tabs contain portlets in the main area of the screen.

The detailsfor each SOA Systinet tab are accessiblein the User Interface->Soa Systinet tab->Portlets
branch of the Extension Explorer (see User Interface on page 25).

All the portletsin your extension are accessiblein the User I nterface->Ul Details->Portlets Definitions
branch in the Extension Explorer (see User Interface on page 25).

Configuring the portlets of a SOA Systinet tab and creating new portlets are described in Configuring
the SOA Systinet Ul on page 63.

Artifact pages consist of the page heading, a set of contextual menus and the main layout of the page:

Getting Started 15



Figure 2. SOA Systinet Artifact Page
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The two configurable elements on artifact pages are:

1

Contextual Action Menus

The contextual menus are organized into Ul groups and contextual actions.

6
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The details for each artifact type are accessible in the Service Catalog Ul and T ools Ul tabs of the
relevant artifact editor (see Artifact Types on page 23).

All the contextual actions and groups of actionsin your extension are accessiblein the User I nterface-
>UI| Details->Contextual Actionsand Contextual Action Groupsbranchesin the Extension Explorer
(see User Interface on page 25).

Configuring the contextual menus of an artifact pageis described in Manipulating Artifact Types on
page 31. Creating context actions and organizing them into groupsis described in Configuring the SOA
Systinet Ul on page 63.

Page L ayout
The page layout of artifact detail pages can be configured.

The details for each artifact type are accessible in the Service Catalog Ul and Tools Ul tabs of the
relevant artifact editor (see Artifact Types on page 23).

Configuring the layout of an artifact page is described in Manipulating Artifact Types on page 31.

Creating an Extension Project

The first step in customizing your installation isto create an extension project in the Customization Editor.
Thisis your workspace where you make all your modifications.

To create an extension project:

In the File menu, select New—>HP SOA Systinet Extension Project.

Complete the dialog with parameters:

Parameter Definition

Platform Home Use Browseto select the SOA Systinet platform installation folder

Extension Folder Use Browse to select the extension folder in your SOA Systinet
installation (populated by default based on the Platform Home
input

Getting Started 17
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Parameter Definition

Server URL The URL used to access SOA Systinet in the form -
http://1ocal host: 8080/ soa

Develop JSPs Select Develop JSPs to enable component development in
Customization Editor

JBoss Deploy Directory Use Browse to select the deployment directory for your application
server (usually JBosS_HOVE\ ser ver\ def aul t\ depl oy)

JBoss INDI Port Input the INDI Port for your application server.

» Only JBossis supported for the development of components and tasks in this release.

Click Next to select the type of extension project:
Select one of the three options:

« Createanew extension project from scratch —this creates an empty extension containing no elements
at al. Thisisthe default option for most uses of the Customization Editor.

« Edit an existing extension — open an extension for modification.

« Create anew extension from an existing one — use an existing extension as the basis of anew one.
If you use this option, the existing extension must be removed from the extensions folder before
you deploy the new extension.

For the last two options select an extension from the extension folder or use Add Extension to select
one from another location.

Click Next.
Edit extension skipsto Step 7.

For the create options compl ete the dialog with parameters:

Chapter 1



Parameter Definition

Name The name of your extension project

Namespace The prefix used for the URI when creating a new artifact type or property
Description A description of your extension project

Version The extension version number

URI The unique identifier of the extension

Click Next to select an extension dependency.

6 For the create options you can optionally add dependencies on other extensions. All extensions are
dependent on the core extension.

Select extensions from the list or use Add extension to add an extension from outside the default
extensions directory to thelist. Click Next to set the extension properties.

7 Complete the dialog with the following parameters:

Parameter Definition

Project Name The name of the new extension project

Location Optionally, deselect Default L ocation and use Browseto select anew workspace
directory

8  Click Finish to create the project.

Inthe HP SOA Systinet perspective, the Extension Explorer (see Navigating the Customization Editor
on page 21) now displays aview of your extension which contains not only the elements contained in your
extension project but all the elements from any other extensions that your project depends on.

Introduction to the User Interface

The default HP SOA Systinet perspectiveis split into three sections with menu options across the top. On
theleft isatree view of the SDM configuration. The main section contains the details of theitem highlighted
on the left. Multiple editors can be open in this main section and the functionality varies depending on the
editor. In the bottom-right are views for tracking problems, actions, and searches.

Getting Started
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Figure 3. Customization Editor Ul
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The details of the user interface are described in:

e Navigating the Customization Editor on page 21. The Extension Explorer isthe main navigation view
for the Customization Editor.

» User Interface Reference on page 99 describes the functionality of each editor and view inthe main and
bottom-right sections.
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Navigating the Customization Editor

The Extension Explorer represents atree view of the extension project that you are currently working
with. It includes all the elements from extensions that it depends on as well.

) 2 Note: Y our changes are stored in your extension. Y ou can change the labels abd descriptions of
elements from dependent extensions but you cannot delete them or make any other changes. If
you want to delete an element from a dependent extension then deprecate it.

Getting Started 21



Figure 4. Extension Explorer View
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Double-clicking an item in the tree will open the relevant editor in the main section and also open/close a
branch.

Right-clicking an el ement opens a context menu of options relevant to the particular element.
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Thetreeis split into the extension root and five branches representing different elements of your extension.
The functionality within each element is described in the following sections:

* Your Extension on page 23 describes the top level object in the extension.

» Artifact Typeson page 23 contains the hierarchical structure of the artifact types and packages within
the extension.

e SDM Details on page 24 contains properties and property groups.

» User Interface on page 25 contains the customizable elements of the SOA Systinet user interface.
» Taxonomies on page 26 accesses the categorization groups available within this extension.

e project.xml on page 26 is configuration of the current extension project.

Your Extension

The extension name is the root element of the project.

Theright-click context menu contains the option to Build Extension which creates ajar containing your
extension ready to import to SOA Systinet (see Deploying an Extension to SOA Systinet on page 91).

Artifact Types

The Artifact Types branch contains the artifact types organized into a hierarchical structure reflecting the
SOA Model.

Each element below Artifact Typesisatypeof artifact or artifact package and the right-click context menu
has the following functionality:

» New Artifact Type/Package creates a new artifact type as described in Creating an Artifact Type or
Package on page 31.

* Open Artifact Type/Package opens the artifact editor for the selected element with the name of the
element as the editor title. The functionality of this view is described in Artifact Editor on page 100.

e DeprecateArtifact Type/Package. After confirmation, the artifact type becomesinactivein the extension
project and is hidden in the SOA Systinet UI.
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Undeprecate Artifact Type/Package. After confirmation, the artifact type reactivatesin the extension
project.

Delete Artifact Type/Package. After confirmation, the artifact type is removed from the extension
project.

2

An artifact package is an artifact type that serves as a group of other artifacts. They do not have
instances in the repository and just serve to organize a hierarchy of artifact typesin the SDM.

SDM Details

The SDM Details branch contains two element types:

24

Property Descriptors of which there are three types:

Primitive Property
Relationship Property

Taxonomy Property

The parent branches contain one context menu option:

New Property opens adialog described in Creating a Property on page 51.

Within each parent element isthe list of properties of that type. The context menu for properties contains
the following options:

Open Property opens the property editor for the selected element with the name of the element as
the editor title. The functionality of this view is described in Property Editor on page 111.

Deprecate Property. After confirmation, the property becomes inactive in the extension project
and is hidden in the SOA Systinet Ul.

Undeprecate Property. After confirmation, the property reactivates in the extension project.

Delete Property. After confirmation, the property is removed from the extension project.

Chapter 1



» Find Usage opens a search view displaying all the artifacts and property groups that contain this
property as described in Search View on page 134.
* Property Groups
The context menu of the parent element only has one option:
« New Property Group opens adiaog described in Creating a Property Group on page 60.
The context menu for each property group has these options:

e Open Property Group opens the property group editor for the selected element with the name of
the element as the editor title. The functionality of this view is described in Property Group Editor
on page 115.

e Delete Property Group. After confirmation, the property group is removed from the extension
project.

» Find Usage opens a search view displaying all the artifacts that contain this property group as
described in Search View on page 134.

User Interface

The User Interface branch contains a branch for each tab in the SOA Systinet Ul and a Ul Details branch
containing Ul elements.

The branch for each SOA Systinet tab contains two elements:

» Navigation. Double-click to open the view for that SOA Systinet tab allowing you to customize the
menusin SOA Systinet. The functionality of the Navigation editor is described in Navigation Editor
on page 116.

* Portlets. Double-click to open theview for that SOA Systinet tab allowing you to customize the portlets
that are available on the selected SOA Systinet tab. The functionality of the Portlets editor is described
in Portlets Editor on page 118.

Ul Details contains the following elements:
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e Componentsare elements called by the SOA Systinet Ul to perform aparticular function. Double click
to open theview described in Components Editor on page 120 or right-click and select New Component
to start the dialog described in Creating a Component on page 79.

e Contextual Action Groups alow you to group context actions together and add them to the context
optionsin the SOA Systinet Ul. Double-click to open the view described in Contextual Action Groups
Editor on page 121 or right click and select New Context Action Group to start the dialog described in
Creating a Context Action Group on page 72.

» Contextual Actionsare menu options available within artifact and service pagesin the SOA Systinet
Ul. Doubleclick to open the view described in Contextual Actions Editor on page 122 or right click and
select New Context Action to start the dialog described in Creating a Contextual Action on page 70.

e Navigation Actions arethe linksin SOA Systinet that navigate between pages. Double click to open
the view described in Navigation Actions Editor on page 124 or right click and select New Navigation
Action to start the dialog described in Creating a Navigation Action on page 68.

» Pergpectives control the views available to usersin SOA Systinet. Double click to open the view
described in Perspectives Editor on page 125 or right click and select New Per spectiveto start the dialog
described in Creating a Perspective on page 74.

» Portlets Definitions are the components in the main section of SOA Systinet pages. Double click to
open the view described in Portlets Definitions Editor on page 126 or right click and select New Por tlet
to start the dialog described in Creating a Portlet on page 75.

e Tasksare Ul wrappers for components. Double click to open the view described in Tasks Editor on
page 127 or right-click and select New T ask to start the dialog described in Creating a Task on page 81.

Taxonomies

The Taxonomies branch allows you to control the taxonomies that are available within your extension
project. Double-click to open the view described in Taxonomies Editor on page 129.

project.xml

The project.xml branch accesses the view alowing you to configure the current extension project as
described in project.xml Editor on page 130.
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Customization Editor Menu Options

Themenusin Customization Editor are the normal Eclipse menuswith the addition of specific functionality
for the Customization Editor.

The extra menu options in the Customization Editor include:

File->New->HP SOA Extension Project to start a new project as described in Creating an Extension
Project on page 17.

File->New->Artifact Typeto create an artifact type as described in Creating an Artifact Type or Package
on page 31.

File->New->Artifact Package to create an artifact package as described in Creating an Artifact Type
or Package on page 31.

File->New->Property to create a property as described in Creating a Property on page 51.

File->New->Property Group to create a property group as described in Creating a Property Group on
page 60.

File->New->Per spective to create a perspective as described in Creating a Perspective on page 74.
File->New->Component to create a component as described in Creating a Component on page 79.
File->New->Task to create atask as described in Creating a Task on page 81.

Navigate->Go To->Open Artifact to open an artifact editor as described in Artifact Editor on page
100. The keyboard shortcut Ctrl+Alt+A aso performs this function.

Navigate->Go To->Open Property to open a property editor as described in Property Editor on page
111. The keyboard shortcut Ctrl+Alt+P also performs this function.

Navigate->Go To->Open Property Group to open a property group editor as described in Property
Group Editor on page 115. The keyboard shortcut Ctrl+Alt+R a so performs this function.

Sear ch->Sear ch opens a search dialog as described in Searching the Extension on page 28.
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e Help->Dynamic Help accesses context sensitive help, directing you to the relevant section of this
document based on the active view in the Customization Editor.

Searching the Extension

The Customization Editor contains a customized search function that enables you to find entities in the
extension project.

To search your extension project:

1 Inthe Sear ch menu select Sear ch to open the Sear ch dialog:

[A Search @

0 SOM search | B File Search | 27 Java Search

Containig text:

v | [ case sensitive

{* = anty string, 7 = any character, \ = escape for iterals: * 7 \) [_] Regular expression

Search For Search In
Artifact Type Display name
Froperty Lacal Name
Froperty group Description
Scope

Extension: (@) Al Extensions () Active Extension

Project:

@ [ Search H Cancel

2 Complete the SDM sear ch dialog containing parameters:

Parameter Definition
Containing text The parameter to search the extension for
Case sensitive Check the box to make the search case sensitive
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Parameter Definition

Regular expression Allows more sophisticated search parameters. For example, to find
everything with more than one word. Thisis an advanced topic beyond the
scope of this guide.

Search For Select the SDM entities to search
Search In Select the entity attributes to search
Scope Select the extension to search

3 Click Search to execute the search and view the resultsin the Sear ch view (see Search View on page
134).

Saving Modifications
Asyou modify an entity in your extension project thetab label of the entity editor is marked with an asterisk.

To save your changes to the project select File->Save from the File menu or use the keyboard shortcut
Ctrl+S.

If you close an editor or the application with unsaved changes you are prompted to save these changes.

These changes are made to your extension project and not to the configuration of SOA Systinet. To deploy
your modificationsto SOA Systinet see Deploying an Extension to SOA Systinet on page 91.
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2 Manipulating Artitact Types

The Customization Editor can be used to create, modify and delete artifact typesin your extension project.
Y ou can a'so change the format of artifact pagesin the SOA Systinet Ul.

The chapter describes the following procedures:

» Creating an Artifact Type or Package on page 31

* Maodifying the Attributes of an Artifact Type on page 35

* Modifying the Properties of an Artifact Type on page 36

* Modifying an Artifact Type in the Services Ul on page 37

» Maodifying an Artifact Type in the Tools Ul on page 37

* Modifying the Layout of the View Artifact Page on page 38
* Modifying the Contextual Actions of an Artifact on page 41
* Mapping an Artifact Type to a Registry on page 43

* Example: Adding the Department Property to Business Services on page 47

Creating an Artifact Type or Package

This procedure describes how to create a new artifact type or package in your extension project. For more
information on artifact types and packages, see SDM Elements on page 13.

Tocreate an artifact type:

1 To start the New Artifact Typedialog:
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e IntheFile menu select New->Artifact Type/Package.

e Alternatively, in the Extension Explorer right-click Artifact Typesand select New Artifact
Type/Package.

» Alternatively, in the Extension Explorer right-click an artifact package branch and select New
Artifact Type/Package to create anew artifact type as part of that package.

The New Artifact Type or New Artifact Package dialog appears:

[ New Artifact Type @

New Artifact Type

Create a new artifact type /

Display name ‘wayhil
Local Mame waybill
LRI urnicom:systinet:soa:model: artifacts: soa:waybil

Collection Display Mame | Waybills

Package S04/ E]
Extends E]
Description W ayhill

@ [ Mext = ] [ Finish ] [ Cancel ]

2 Complete the dialog which contains the following parameters:

Parameter Definition
Display Name The name of the artifact as it appearsin the SOA Systinet Ul

Local Name The name of the artifact asit is stored in the extension

URI Theidentifier of the artifact descriptor in the configuration
Collection Display | The plural name of the artifact as it appearsin the SOA Systinet Ul
Name
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Parameter Definition

Package A browse button allows you to select the parent artifact type that this artifact
type belongs to

Extends A browse button allows you to select an artifact type to inherit the properties
from

» Note: If you select Extends, any future changes to the chosen parent
artifact are inherited by the new artifact.
Description The description of the artifact type asit appearsin the SOA Systinet Ul

Do one of the following:

e Click Finish to create the artifact type.

e Continueto Step 4 to set the visibility of the artifact in the SOA Systinet Ul.

4 Click Next.

The New Artifact Type/Package displays visibility parameters:

Manipulating Artifact Types
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[ New Artifact Type @

Artifact Type Visibility

Specify artifact bype visibility, /

[11s artifact available in Service Catalog?
*all*

Visible to:

*al*

Editable by:

@ [ <Back || Mext > |[ Finish H Caniel ]

Complete the dialog which contains the following parameters:

Parameter Definition

Copy User Interface If the new artifact type extends an artifact with an existing Ul configuration

configuration from check the box if you want it to inherit these attributes

parent artifact type?

Isthe artifact available | Check the box if the artifact typeisvisible in the Service Ul

in Service Catalog?

Visibleto Use Add and Remove to select viewing permissionsin the SOA Systinet
ul

Editable by Use Add and Remove to select edit permissionsin the SOA Systinet Ul

Do one of the following:
e Click Finish to create the artifact type.

e Continueto Step 7 to set database parameters.

Chapter 2



7 Click Next.

The New Artifact Type/Package displays database settings.

» These settings cannot be changed if the new artifact extends an artifact type that already
defines them.

Complete the dialog which contains the following parameters:

Parameter Definition

Collection name | The name of collection where the artifact instances are stored

Database table The name of the database table where instances of this artifact are stored
name

8  Click Finish to create the artifact type.

Modifying the Attributes of an Artifact Type

HP SOA Systinet Customization Editor enables you to edit the main attributes of artifact types.

To edit the attributes of an artifact type:
1 Open the artifact editor in the General tab.
2  The General tab displays three editable segments:

e Artifact General Information contains four editable parameters:

Par ameter Definition

Display Name| The name of the artifact asit appearsin the SOA Systinet Ul

Collection The plural version of the name asit appears in the SOA Systinet Ul
Display Name

Description | The description of the artifact type as it appears in the SOA Systinet Ul
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Parameter

Definition

Deprecated

A checkbox indicating whether the artifact is currently active in the extension

e Visbleto

Use Add and Removeto select the perspectivesthat can seethisartifact type within SOA Systinet.

- Editableby

Use Add and Remove to select the perspectives that can amend this artifact type within SOA

Systinet.

Modifying the Properties of an Artifact Type

The main attributes of artifact types are properties. These can be modified, added individually, or added as
agroup within the artifact editor.

To add or modify the properties and property groups of an artifact type:

1 Open the artifact editor and click the Properties tab.

2  ThePropertiestab contains two modifiable segments:

e Properties:

» Click New to create a new property as an attribute of the artifact type and create the property
as described in Creating a Property on page 51.

» Click Add to select a property to add to the artifact type with a selected cardinality and select
where the property appears in the Tools and Services artifact detail pages.

e Click Deprecate to deactivate the property in the artifact type.

» Click Undeprecate to reactivate a deprecated property in the artifact type.

» Select aproperty and click Remove to remove the property from the artifact type.
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e Property Groups.

» Click New to create anew property group as aset of attributes of the artifact type as described
in Creating a Property Group on page 60.

» Click Add to add a property group to the artifact type.

e Select aproperty group and click Remove to remove the group from the artifact type.

Moditying an Artifact Type in the Services Ul

SOA Systinet enables you to configure the appearance of an artifact type in the view artifact page in the
Services Ul.

To modify the appear ance of Services Ul pages.
1 Open the artifact editor and click the Service Catalog Ul tab.

2 Checkthelsartifact availablein Service Catalog? box to make the artifact type visiblein the Services
ul.

3 If theartifact typeisavailable in the Services Ul there are two elements of the view artifact page that
can be modified:

* Tomodify thelayout of the view artifact page see Modifying the Layout of the View Artifact Page
on page 38.

« To modify the contextual actionsin the view artifact page see Modifying the Contextual Actions
of an Artifact on page 41.

Modifying an Artifact Type in the Tools Ul

SOA Systinet enables you to modify the appearance of an artifact type in the view artifact and browse
artifact pages of the Tools Ul.
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To modify the appear ance of Tools Ul pages:
1 Open the artifact editor and click the Tools Ul tab.

2  Therearetwo elements of the View Artifact and Browse Artifact pagesin the Tools Ul that can be
modified:

« To modify the layout of the View Artifact page see Modifying the Layout of the View Artifact
Page on page 38.

» Tomodify contextual actionsintheView Artifact page or the Browse Artifact page see Modifying
the Contextual Actions of an Artifact on page 41.

Moditying the Layout of the View Artifact Page

The View Artifact page showsthe details of an artifact in both the Servicesand T oolstabs of SOA Systinet.
The elements that appear there can be modified with the Customization Editor.

To modify the layout of view artifact pages:

1 Open the artifact editor and click the Service Catalog Ul or Tools Ul tab according to which view
you want to modify.

2 Inthe Layout segment:
* To change the order of elements, select the element and click Up and Down.
* Toremove an element select it and click Remove.

e Toedit an element select it, click Edit and modify the same parameters as appear in the Add
functions.

e Toadd an element click Add:

» Toadd anew layout heading, in which to group properties and components, select Group,
input a name for the group and click Finish to add it to the layout.

e Toadd aproperty:
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1 Select Property and click Next to open the Layout Property Details dialog:

[ Layout

Froperty:

LayoLt group:

Wisible to:

Editable bry:

Property details
Fill in property details,

X

Documents i
* Pk
* Pk

e ) (o

2 Complete the dialog with the following parameters:

Parameter

Definition

Property

Use Browse to select a property to be displayed in the layout

Layout Group

Select the layout heading for the property to be displayed under from
the drop-down list

Visbleto

Use Add and Remove to select the perspectives that can see the
property

Editable by

Use Add and Remove to select the perspectives that can edit the
property

Manipulating Artifact Types
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3 Click Finish to add the property to the layout.

To add anew functional Ul component:

1 Select Component and click Next to open the Layout Component Details dialog:

[ Layout

Component name:

LayoLt group:

Wisible to:

Editable bry:

Component details

Specify component properties,

Component parameters:

| faccount/deletesccount | IBrowsel
|Documents v |
*
*
Key  Walue
Add ..

Remave

’ Finish ] ’ Cancel

2 Complete the dialog with the following parameters:

Parameter Definition

Component Use Browse to select the component

Name

Layout Group | Select the layout heading that the component is part of
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Parameter

Definition

Visbleto

Use Add and Remove to select the perspectives that can see the
component

Editable by

Use Add and Remove to select the perspectives that can edit the
component

Component
parameters

Use Add and Remove to select parameters to use with the component

3 Click Finish to add the component to the layout.

» This component must also be created using the procedure described in Creating a Task

on page 81.

Modifying the Contextual Actions of an Artifact

At the top of the View Artifact page in both Services and Tools and the Browse Artifact pagein Tools
is a section containing sets of Contextual Actions. The actions that appear there can be modified with the

Customization Editor.

To modify the contextual actionsin view and browse artifact pages:

1 Open the artifact editor and click the Service Catalog Ul or Tools Ul tab according to which view

you want to modify.

2 Inthe Contextual Actions segment:

» Inthe Tools Ul tab this segment contains two tabs:

e Artifact Detail refersto the View Artifact page.

Manipulating Artifact Types
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e Collection refersto the Browse Artifact page.

» To change the order of actions, select the action and click Up and Down.
* Toremove an action select it and click Remove.

* To edit an action element select it, click Edit and modify the same parameters as appear in the
Add functions.

* Toadd an action element click Add:

e Toadd acontextual menu heading select Ul Group, input a display name for the group and
click Finish to add it to the context menu.

e To add acontextual action item:

1 Select Contextual action item and click Next to open the Contextual Action Item Details
dialog:

[ Contextual Actions @

Contextual Action Item Details

Fill in the contextual action item details,
Display name: Create Implementation
Description: Create an Implementations for this Service
Action ID: implementationArtifactMew
UI group: Default w

*all*

Visible to:
@ [ Finish ] [ Cancel ]

2 Complete the diaog which contains the following parameters:
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Parameter Definition

Display Name | The name of the action as it appearsin the SOA Systinet Ul

Description The description of the context action

Action Select the action from the list

Ul Group Select the action menu that the action is part of

Visibleto Use Add and Remove to select the perspectives that can see the
property

3 Click Finish to add the element to the context action menu.

* Toadd aset of contextual actions to the menu:

1 Select Contextual action group reference and click Next to open the Group reference
detail dialog.

2 Select the Contextual action group for the required set of actions and the Ul group that
the actions appears in and click Finish to add the set of actions to the contextual menus.

Mapping an Artifact Type to a Registry
Artifactsin SOA Systinet can be mapped to registry entitiesin aUDDI registry.

The following artifact types have predefined mappings to registry and cannot be amended:
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Table 1. Predefined Registry Mapping

SDM artifact UDDI entity Direction

Organizational Unit BusinessEntity Bi-directional
Business Service tModel Bi-directional
Implementation Artifacts Business Service Bi-directiona
Endpoint BindingTemplate Bi-directional

Figure 5 illustrates the mapping of an artifact to aregistry entity:

Figure5. Registry Mapping

Systinet2 UDDI Registry

-

T’

Property 1

———

Property 2

Artifact

To add or modify artifact type mappingsto registry entities:

Keyed Reference
KeyWame and KeyValue setin
Customization Editor

Keyed Reference

KeyName set in Customization Editor
HKeyValue taken from property value
In Systinet2

Keyed Reference

KeyName set in Customization Editor
HKeyValue taken from property value
in Systinet2

tModel

1 Open the artifact editor and click the Registry M apping tab.

2 Thefunctionality of the Artifact M apping segment and Property Mapping is the same:

» To edit amapping, select the mapping, click Edit and modify the same parameters as appear in

the Add functionality.
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e Toremove a mapping select the mapping and click Remove.
e Toadd aregistry mapping for an artifact type:

1 IntheArtifact Mapping segment click Add to open the New Artifact M apping dialog:

[ Registry Mapping @

New Artifact Mapping

Add a new registry mapping For artifack

Registry all others
T-Modelkey uddi:systinet, com:acl
T-Modelkey version 2

Key Mame Business Entity

Key Value

Advanced options
Display name
Cache content []

Direction Bath v

(3] [ Finish H Cancel ]

2 Complete the dialog with the following parameters:

Parameter Definition

Registry Use Select to select from the available registries
T-ModelKey Use Add to select from the available taxonomies or input one

T-ModelKey If you are mapping to aUDDI version 2 registry input ataxonomy key

version 2
Key Name The name used to categorize the UDDI entity in the registry
Key Value The value used to categorize the tModel in the registry
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Parameter Definition

Display Name | The name of the mapping as it appearsin the SOA Systinet Ul

Cache content | If selected, the content of documents referenced from the UDDI entity
are cached in SOA Systinet

Direction Select the direction of the mapping from the drop-down list

3 Click Finish to add the mapping.

e Toadd aregistry mapping for a property:

1 Inthe Property Mapping segment click Add to open the New Property Mapping dialog:

[ Registry Mapping @

New Property Mapping
Add a new registry mapping for property

Property Description
Direction Bath v
Registry -
T-Modelkey uddi:systinet,com:demo: departmentid
T-Modelkey version 2

Key Mame

@ [ Finish ] [ Cancel ]

2  Complete the dialog with the following parameters:

Parameter Definition

Property Use Select to select from the available properties
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Parameter Definition

Direction Select the direction of the mapping from the drop-down list
Registry Use Select to select from the available registries
T-ModelKey Use Add to select from the available taxonomies or input one

T-ModelKey If you are mapping to a UDDI version 2 registry input ataxonomy key
version 2

Key Name The name used to categorize the UDDI entity in the registry

3 Click Finish to add the mapping.

Example: Adding the Department Property to Business Services

In this example, you add a new taxonomic property, department, to the business service artifact, and make
it visiblein the service view of abusiness service.

Figure 6. Default Service View of a Business Service

Transaction Services

Business Service Services = View Service
Financial Transactions
Views - Tools ~ Compliance -~ Requests - m
Owner: administrator ([ admin e-mail ] )

Version:
Failure Impact:

Keywords:

Associated Approval == Undefined ==
Process:

Contact: Transaction Services
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To follow this example requires the following prerequisites:

Create a new extension dependent on the core extension, as described in Creating an Extension Project
on page 17.

Create the new department taxonomy and deploy it to SOA Systinet, as described in the Example:
Creating and Publishing a Department Taxonomy section of the HP SOA Systinet Taxonomy Editor
Guide.

To add the department property to business services:

1

2

9

Open the business service editor and navigate to the Propertiestab.

Click New to add anew property as described in Modifying the Properties of an Artifact Type on page
36.

Select Taxonomy Property and click Next.

Input Depart rent as the Display Name.

For the Taxonomy, click Browse and import the Depar tments taxonomy.

Click Next to set the visibility of the department property.

For the Service Catalog Ul group, select Service Properties, and then click Finish.
Press Ctrl+S to save your changes to the business service artifact type.

Deploy your extension, as described in Deploying an Extension to SOA Systinet on page 91.

10  Start your installation of SOA Systinet.

After you deploy this customization, the service properties section of the service view of abusiness service
includes the new department property.
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Figure 7. Customized Service View of a Business Service

Transaction Services

Business Service

Services » View Service
Financial Transactions

Views ~ Tools ~

corprcs - Rt [ can | oeiere
Service Properties =]
Owner: administrator ([ admin e-mail ] )
Version:

Failure Impact:

Keywords:

Associated Approval == Undefined ==
Process:

Contact: Transaction Services
Department:

This property can now be set during business service creation.
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3 Manipulating Properties

The Customization Editor enables you to create, modify and delete properties and property groupsin your
extension project.

The property procedures are:

» Creating a Property on page 51 describes how to create properties of types:
e Primitive
e Rdationship

e Taxonomy

* Modifying aProperty on page 57

e Creating a Property Group on page 60

» Maodifying a Property Group on page 61

Manipulating Artifact Types on page 31 includes these procedures which are also related to properties:

» Maodifying the Properties of an Artifact Type on page 36 describes how to add propertiesto an artifact.

» Mapping an Artifact Typeto aRegistry on page 43 describes how to add registry mappingsto an artifact
and its properties.

Creating a Property

This procedure describes how to create a new property descriptor in your extension project. For more
information on properties, see SDM Elements on page 13.
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To createa property:
1 Do one of the following:
* IntheFile menu select New->Property.

e Alternatively, inthe Extension Explorer right-click Property Descriptor sand select New Property
and the property type.

e Alternatively, in the Extension Explorer right-click a property type branch and select New Type
Property to create a property of that type.

The New Property dialog appears.
2 A different dialog opens depending on the property type:

* For primitive properties:

[ New Property @

New primitive property

Create a new primitive property /

Display Mame: destination
Local Mame: destination
LRI: urnicom:test: properties: destination

Collection Display Mame: | destinations

Description: destination
Property Type: plainTextPropertyType
@ [ Mext = ] [ Finish ] [ Cancel ]

Complete the dialog which contains the following parameters:
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Par ameter Definition

Display Name The name of the property asit appearsin the SOA Systinet Ul

Local Name The name of the property asit is stored in the extension

URI Theidentifier for property in the configuration

Collection Display The plural name of the property as it appearsin the SOA Systinet Ul

Name

Description The description of the property asit appearsin the SOA Systinet Ul

Property Type Use Browse to select a property from the available primitive property
types

« For relationship properties which are created in pairs:

Manipulating Properties
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[ New Property

Display Mame:
Local Mame:
URI:

Collection Display Mame:

Description:

Relation bype:

From Artifack:

Tor Artifack:

Inverse Display name:
Inverse Local Mame:
Inverse URI:

Inverse Collection Display Mame:

Inverse Relationship Description:

New relationship property

Create a new relationship property /

[

| distance |

| distance |

| urnicom:test: properties: distance |

| distances |
distance

| urnicom:systinet:soa:model: property Types: documentRelationship w |

| Contact | [Browse... ]

| Organizational Unit | [Browse... ]

| return distance |

| returnDistance |

| urnicon:tesk:properties returnbistance |

| return distances |

return distance

[ Mext = H Finish H Cancel ]

Compl ete the dialog which contains the following parameters:

Par ameter Definition

Display Name The name of the property asit appearsin the SOA Systinet Ul
Local Name The name of the property asit is stored in the extension

URI The identifier for the property in the configuration
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Parameter

Definition

Collection Display
Name

The plural name of the property as it appears in the SOA Systinet Ul

Description The description of the property asit appearsin the SOA Systinet Ul
Relation Type Select atype from the drop-down list

From Artifact Use Browse to select the source artifact type of the relationship

To Artifact Use Browse to select the target artifact type of the relationship

Inverse Display Name

The name of the inverse relationship property asit appears in the SOA
Systinet Ul

Inverse Loca Name

The name of the inverse relationship property asit is stored in the
extension

Inverse URI

The identifier for the inverse property descriptor in the configuration

Inverse Collection
Display Name

The plural name of the inverse relationship property asit appearsin the
SOA Systinet Ul

Inverse Relationship
Description

The description of the inverse relationship property asit appearsin the
SOA Systinet Ul

For taxonomy properties:

Manipulating Properties
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[ New Property

New taxonomy property

Create a new baxonomy property

Collection Display Mame: | carriers

Description: carrier

Display Mame: carrier
Local Mame: carrier
LRI: urnicon:tesk:properties:carrier

Taxononmy: uddi:systinet, com:resource:location

[ Mext = H Finish H Cancel ]

Complete the dialog which contains the following parameters:

Par ameter Definition

Display Name The name of the property asit appearsin the SOA Systinet Ul

Local Name The name of the property asit is stored in the extension

URI Theidentifier for the property in the configuration

Collection Display The plural name of the property asit appearsin the SOA Systinet Ul

Name

Description The description of the property asit appearsin the SOA Systinet Ul

Taxonomy Use Browse to select ataxonomy from the available taxonomies with
an option to import taxonomies available in SOA Systinet that are not
in your extension.

3 Do oneof thefollowing:
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e Click Finish to create the property.

» Continueto Step 4 to set property visibility.

4 Click Next.

The New Property dialog displays visibility parameters:

[ New Property @

Property Type Yisibility
Specify property visibility,

*al*

Visible to:

*al*

Editable by:

/

[

Finish

] [ Cancel

]

5  Complete the dialog which contains the following parameters:

Parameter Definition
Visibleto Use Add and Remove to select viewing permissions in the SOA Systinet Ul
Editable by Use Add and Remove to select edit permissionsin the SOA Systinet Ul

6 Click Finish to create the new property.

Moditying a Property

HP SOA Systinet Customization Editor enables you to modify properties.

Manipulating Properties
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To edit a property:

1

2

58

Open the property editor.

Edit the general attributes of the property in the Gener al tab and the advanced attributesin the Advanced
tab.

e The General tab contains the following editable segments:

* General contains the following editable parameters:

Par ameter Definition

Display Name| The name of the property asit appears in the SOA Systinet Ul

Description | The description of the property asit appearsin the SOA Systinet Ul

Collection The plural version of the name as it appears in the SOA Systinet Ul
Display Name

Deprecated | A checkbox indicating whether the property iscurrently activein the extension

* Therearethreetypesof property and the second segment is specific to each:
e Property Type
Primitive properties are not editable and just display the property type.
e Relationship
Use Add and Remove to select the endpoints of the relationship.
e Taxonomy

Use Browse to select a new taxonomy from the extension project.

e Visbleto

Use Add and Removeto select the perspectivesthat can see this property within SOA Systinet.
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. Editableby

Use Add and Remove to select the perspectives that can amend this property within SOA

Systinet.

e The Advanced tab contains the following editable segments:

* Multiple Cardinality contains the following editable parameters:

Parameter Definition

MinOccurs | For multiple cardinality enter aminimum number of instances of the property

MaxOccurs | For multiple cardinality enter amaximum number of instances of the property.
Use unbounded if thereisno limit.

e Default Values contains the following editable parameters:

Parameter Definition
Default Value | Default valueisdescribed by an XML element which must follow therules
defined by XML schemafor the selected property and property type. For
example, aprimitive plain text property with local name email is defined
by
<p: emai |
xm ns: p="http://systinet.conf 2005/ 05/ soa/ model / property" >val ue</ p: enai | >
Multiple Default | If the property has multiple cardinality then specify more than one default
Vaue value. For example, aplain text property with local name email and multiple

cardinality is defined by

<g: emai | G oup
xnl ns: g="http://systinet.conm 2005/ 05/ soa/ nodel / pr opert yG oup”
xnl ns: p="http://systinet.com 2005/ 05/ soa/ nodel / property">
<p: emmi | >val uel</p: email >
<p: emmi | >val ue2</ p: emai | >
</ g: emai | G oup>
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e Database Sizes enables you to optionally set the storage size of property elements with Add,
Edit and Remove functionality.

Creating a Property Group

As many artifacts share sets of the same propertiesit is useful to create groups of properties and add these
to the artifacts instead.

To create a property group:
1 Do one of the following:
e IntheFile menu select New->Property Group.

e Alternatively, in the Extension Explorer right-click Property Groups and select New Property
Group.

e Alternatively, in the artifact Propertiestab click New in the Property Groups segment to create
anew group as aset of attributes for an artifact type.

The New Property Group dialog appears:
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[ New Property Group

New Property Group

Create a new property group

Display name | Contact Details

Properties

Mame  Cardinality = Extension

Mame  required cormpany
Email  multiple company

X

/

LRI com.systinet, soa, ext.company: propertyGroups: contactDetails

[

Finish

] [ Cancel

]

2 Complete the dialog which contains the following parameters:

Parameter Definition

Display Name The name of the property group as it appears in the SOA Systinet Ul
URI Theidentifier for the property group descriptor in the configuration
Properties Use Add and Remove to select the propertiesin the group

3 Click Finish to create the property group.

Moditying a Property Group

HP SOA Systinet Customization Editor enables you to modify property groups.

To edit a property group:

1 Open the property group editor.
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2 Modify the property group with one of the following functions:
« Edit the General segment to change the display name of the property group.

e Click New under Propertiesto create a new property as part of the group as described in Creating
a Property on page 51.

e Click Add to add a property to the group from the list of available properties.

» Click Remove to remove a property from the group.
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4 Contiguring the SOA Systinet Ul

The main tabsin SOA Systinet can be modified and also the appearance of artifact pages can be atered
using the Customization Editor

The proceduresfor altering the appearance of artifact pagesarein Manipulating Artifact Types on page 31.
This section dealswith creating and modifying Ul elements and modifying the appearance of the main SOA
Systinet tabs.

The available procedures are:

* Adding Portletsto a SOA Systinet Tab on page 64.

e Adding Navigation Groupsto a SOA Systinet Tab on page 65.
e Adding Navigation Actionsto an SOA Systinet Tab on page 66.
e Adding Componentsto a SOA Systinet Tab on page 67.

e Creating a Navigation Action on page 68.

» Creating a Contextual Action on page 70.

» Creating a Context Action Group on page 72.

e Adding Context Actionsto a Group on page 73.

» Creating a Portlet on page 75.

» Creating an RSS Feed Portlet on page 76.

e Creating a Per spective on page 74.
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Adding Portlets to a SOA Systinet Tab

The Customization Editor can be used to configure the portletsthat are availablein each tab in SOA Systinet
and where they appear on the tab.

Toadd portlet to a SOA Systinet tab:

1 Open the Portlets editor for the SOA Systinet tab you want to modify.

2 Click Add to open the New Portlet Placement dialog:

[ Portlet Placement @

New Portlet Placement
Add a new portlet placement
Portlet Reference: | informationManager
Display name: Info|
@ Page
Location:
O Menu
Calurnn: colurnnl v
Permanent:
*all*
Visible to:
@ [ Finish ] [ Cancel ]

3 Complete the dialog which contains the following parameters:

Parameter

Definition

Portlet Reference

Click Browse to select from the available portlets

Display Name

The name of the portlet asit appearsin the SOA Systinet Ul
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Parameter Definition

Location There are two options:
e Page. The portlet is open in the main area of the SOA Systinet tab

* Menu. Theportlet is closed but available to add in the left menu

Column If the portlet is located on the page then use the drop-down list to select which
column it appearsin

Permanent If Menu is selected check this box to enable multiple instances of the portlet.

Visibleto Use Add and Remove to select the perspectives that can see the portlet

4 Click Finish add the portlet to the SOA Systinet tab.

Adding Navigation Groups to a SOA Systinet Tab

The Customization Editor can be used to configure the menu in each SOA Systinet tab. The itemsin the
menu are organized into sections.

To add a navigation group to an SOA Systinet tab:

1 Open the Navigation editor for the SOA Systinet tab you want to modify.
2 Click Add to open the Choose Type dialog.

3 Select Group and click Next to open the Group Details dialog.

4 Complete the dialog which contains the following parameters:

Par ameter Definition

Group Name The name of the group heading as it appearsin the SOA Systinet Ul
Description A description of the new navigation group

Visibleto Use Add and Remove to select viewing permissionsin the SOA Systinet Ul
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5  Click Finish add the group to the SOA Systinet tab menu.

Adding Navigation Actions to an SOA Systinet Tab

The Customization Editor can be used to configure the menu in each SOA Systinet tab. Each item in the
menu corresponds to a navigation action linking to another page in SOA Systinet.

To add a navigation item to an SOA Systinet tab:

1 Open the Navigation editor for the SOA Systinet tab you want to modify.

2 Click Add to open the Choose Type diaog.

3 Select Item and click Next to open the Menu Item dialog:

Menu item
Fill in menu item details,
Tkem name: Procurement|
Ackion 1D navigatio,home w
ErOUp name: To Do L3
Description:
*all*
Visible to:
@ [ Finish ] [ Cancel ]

4 Complete the dialog which contains the following parameters:

Parameter Definition

Item Name The name of the navigation link asit appearsin the SOA Systinet Ul
Action ID Select the Navigation Action from the drop-down list

Group Name Select the menu heading that the item is part of from the drop-down list
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Parameter Definition

Description A description of the new navigation item

Visibleto Use Add and Remove to select the perpectives that can see the item

5  Click Finish add the item to the SOA Systinet tab menu.

Adding Components to a SOA Systinet Tab

The Customization Editor can be used to configure the left-menu in each tab in SOA Systinet. Some items
in the menu are links to a component that performs specific functionality.

To add a component to a SOA Systinet tab:
1 Open the Navigation editor for the SOA Systinet tab you want to modify.
2 Click Add to open the Choose Type diaog.

3 Select Component and click Next to open the Component Details dialog:

[ Menu g|
Component details
Specify component properties,
Component ackion: Tbrowse fwaybillartifacts
ErOUp name: Cuskom Yiews L3
*all*
Visible to:
Key | Walue
Component paramekers: -
-Remove
@ Finish ] [ Cancel
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4 Complete the dialog which contains the following parameters:

Par ameter Definition

Component Action| The identification of the component

Group Name Select the menu heading that the component is part of from the drop-down list
Visibleto Use Add and Remove to select the perspectives that can see the component
Component Use Add and Remove to select parameters to use with the component
parameters

5  Click Finish add the component to the SOA Systinet tab menu.

Creating a Navigation Action

Navigation actions are links from the tab menus to pagesin SOA Systinet.

To create an action:
1 Do one of the following:

* Right-click the Navigation Actionsbranchinthe Extension Explorer and select New Navigation
Action.

e Alternatively, click New in the Navigation Actions editor.

The New Action dialog appears.
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[ New Action

New Action

Flease provide action details

Action 10 browse

Task location: Tbrowse
Key | Walue

Task parameters;

Partner:

Partner path:

Remave

[ Finish H Cancel ]

2 Complete the dialog which contains the following parameters:

Parameter Definition
Action ID Theidentification of the contextual or navigation action
Task Location The name of the action that for is called when the user clicks the link
Task Parameters | Use Add and Remove to select the task parameters for the navigation or
contextual action specified in Task L ocation which consist of:
e Key. The name of the parameter
e Value. Thevalue of the parameter
Partner The name of the SSO partner
Partner Path A relative URL pointing to the resource, that is accessed via SSO

3 Click Finish to create the new action.
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> The full URL is compiled from the base URL retrieved from the DB (where the key is the name
of the SSO Partner) and the relative URL.

If SSO is not needed to render the menu item, then only the task location and task parameters are used. If
SSO isrequired (the menu item references a task/resource in a different product than it isrendered in) then
the target URL is composed from partner, partner path and task parameters.

For example:

<action id="tools. newCt her">
<partner>@I| atform sso.identity.id</partner>
<part ner Pat h>web/ publ i shi ng/ st ruct uredFi | e/ wi zar d</ part ner Pat h>
<task | ocation="/publishing/structuredFile/wzard">
<paraneter key="FirstU Statel D'>fileDetail s</paraneter>
</ task>
</ action>

The SSO URL is composed from e.g. http://johngalt:8080/soa/systinet/platform/ +
web/publishing/structuredFile/wizard + ? + FirstUl Statel D=fileDetails to final form
http://johngal t:8080/soalsystinet/pl atf orm/web/publishing/structuredrFil e/wizard?FirstU| Statel D=fileDetail s

Creating a Contextual Action

Contextual actions are links from the context menusin artifact detail and browse pages.

To create an action:
1 Do one of the following:

* Right-click the Contextual Actionsbranchinthe Extension Explorer and select New Contextual
Action.

e Alternatively, click New in the Contextual Actions editor.

The New Action dialog appears.
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[ New Action @

New Action

Please provide action

Action ID:

Target task:

Component name:

Task parameters;

Partner:

Partner path:

details

browse

Use predefined link renderer

IbackContextLost

Key
targetTask

parameterPrefix  simpleLink_

mode

£

Yalue

IbackContextLost
anchar

[ Finish H Cancel ]

2 Complete the dialog which contains the following parameters:

Parameter Definition

Action ID Theidentification of the contextual or navigation action

Use predefined De-select if you want to use a specific component instead of atask
link renderer

Target Task Use Browse to select the task called by the new context action.

Component name

If Use predefined link renderer is not selected use Browse to select the
component

Task Parameters

Use Add and Remove to select the task parameters for the navigation or
contextual action specified in Task L ocation which consist of:

e Key. The name of the parameter

e Value. The value of the parameter
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Parameter Definition

Partner The name of the SSO partner
Partner Path A relative URL pointing to the resource, that is accessed via SSO

3 Click Finish to create the new action.

) 2 The full URL is compiled from the base URL retrieved from the DB (where the key is the name
of the SSO Partner) and the relative URL.

If SSO isnot needed to render the contextual item, then only the task location and task parameters are used.
If SSO isrequired (the contextual item references a task/resource in a different product than it is rendered
in) then the target URL is composed from partner, partner path and task parameters.

For example:

<action id="tool s. newQt her">
<partner>@l atformsso.identity.id</partner>
<part ner Pat h>web/ publ i shi ng/ structuredFi | e/ w zard</ part ner Pat h>
<task | ocation="/publishing/structuredFile/wzard">
<paraneter key="FirstU Statel D'>fileDetail s</paraneter>
</ task>
</ action>

The SSO URL is composed from e.g. http://johngalt:8080/soa/systinet/platform/ +
web/publishing/structuredFile/wizard + ? + FirstUl Statel D=fileDetails to final form
http://johngal t:8080/soalsystinet/pl atf orm/web/publishing/structuredrFil e/wizard?FirstUl Statel D=fileDetail s

Creating a Context Action Group

Asmany artifact types share sets of the context actionsit is useful to make groups of actions and add these
to artifact types instead.

72 Chapter 4



To create a context action group:
1 Do one of the following:

* Inthe Extension Explorer right-click the Contextual Action Groups branch and select New
Context Action Group.

e Alternatively, click Add in the Contextual Action Groups editor.
The Contextual Actions dialog appears.
2 Select Group of Contextual Actions and click Next.

3 Input the display name for the group and click Finish to create the contextual action group.

Adding Context Actions to a Group

Asmany artifact types share sets of the context actionsit is useful to make groups of actions and add these
to artifact types instead.

To add a context action to a group:

1« Inthe Extension Explorer right-click the Contextual Action Groups branch and select New
Context Action Group.

o Alternatively, click New in the Contextual Action Groups editor.
The Contextual Actions dialog appears.

2 Select Action Item and click Next to open the Edit Item dialog:
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Edit Item
Please provide item details,
Display name: Implementation Yiew
Description:
Action standaloneImplementations w
Group Common Actions (View - Common) [Revision Hiskory, Ao v
*all*
Visible to:
@ [ Finish ] [ Caniel ]

3 Complete the dialog which contains the following parameters:

Parameter Definition

Display Name The name of the context action item

Description A description of the item

Action Select the action to add from the drop-down list

Group Select the group to add the action to from the drop-down list
Visibleto Use Add and Remove to select the perspectives that can see the action

4 Click Finish add the action to the group.

Creating a Perspective

Perspectives control the views of SOA Systinet that are available to each user.

To create a per spective:

1 Do one of the following:
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e Inthe Extension Explorer right-click the Per spectives branch and select New Per spective.

o Alternatively, click New in the Per spectives editor.

The New Per spective dialog appears:

[ New Perspective @

New Perspective

Create a new user perspective

Perspective ID: | Buyer

Display name: | Buyer

Description: Procurement Skaff

£

[ Finish H Cancel ]

2 Complete the dialog which contains the following parameters:
Parameter Definition
Perspective ID The name of the perspective in the extension project
Display Name The name of the perspective as it appearsin the SOA Systinet Ul
Description The description of the perspective as it appears in the Ul

3 Click Finish to create the perspective.

Creating a Portlet

Portlets are the componentsin the main section of SOA Systinet tabs with varying functionality depending

on the portlet.
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Tocreatea portlet:

1 IntheExtension Explorer double-click the Portlets Definitionsbranch to open the Por tlets Definitions
editor.

2  Click Add and select Portlet to open the Add Portlet dialog.

3 Input aname and url for the portlet and click Finish to create the portlet.

Creating an RSS Feed Portlet

The RSS feed portletsin the main section of SOA Systinet tabs display up-to-date views of repository data
or links to external RSS feeds.

To create an RSS Feed Portlet:

1 IntheExtension Explorer double-click the Portlets Definitions branch to open the Portlets Definitions
editor.

2 Click New and select Feed to open the Add Feed dialog:

[ Portlet Definitions @

Add feed

Add & new feed here

Partlet ID:
Lrl:
Partner:

[Crultiple instances

3 Complete the dialog which contains the following parameters:

Parameter Definition
Portlet ID Theidentification of the portlet definition
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Parameter Definition

Url The link to the RSS source

Partner The name of the SSO partner

Multiple Instances| Check the box to allow multiple instances of the feed

4 Click Finish to create the feed.
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5 Creating and Using Components

HP SOA Systinet Customization Editor enables you to create custom components, deploy them to the SOA
Systinet Ul directly from the Customization Editor, and to debug your code.

The complete processis:

1

8

Create a new extension project, as described in Creating an Extension Project on page 17, selecting
Develop JSPs, and setting the appropriate application server settings.

Create a component, as described in Creating a Component on page 79.
Create atask to use your component, as described in Creating a Task on page 81.
Create a navigation action to use your task, as described in Creating a Navigation Action on page 68.

Add the navigation item to the Ul, as described in Adding Navigation Actionsto an SOA Systinet Tab
on page 66.

Develop the Javaand JSP that the component uses in Customization Editor, asdescribed in Developing
the Component on page 82.

Deploy the extension directly from Customization Editor, as described in Direct Deployment to SOA
Systinet on page 96.

Debug your code in Customization Editor, as described in Debugging Y our Code on page 83.

Example: Adding aComponent to the Tools Menu on page 84 is astep-by-step walkthrough of this process.

Creating a Component

Components are functional elementswhich can called by anumber of different elementsin the SOA Systinet

Ul.
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To create a component:

1 Do one of the following:

* Inthe Extension Explorer right-click the Components branch and select New Component.

e Alternatively, click Add in the Components editor.

The New Component dialog appears.

[ New Component @

New Component

Create a new component

Mame:
Page:

Class name:

/

testCormponent
JTtestitestComponent. jsp

test.TestComponent|

Mame  Yalue

Component paramekers:
@ [ Finish ] [ Cancel
2 Input the following parameters:
Parameter Definition
Name The name of the component asit is stored in the extension
Page The JSP used by the component.
Class name The Java class used by the component.
Component Use Add and Remove to select parameters to use with the component
parameters
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3 Click Finish to create the component.

Creating a Task

Tasks are top level components accessible viatheir uris. The addition of a uri allows you to access the
component in the SOA Systinet Ul and make more sophisticated multi-layered components.

Tocreate a task:

1 Do one of thefollowing:
e Inthe Extension Explorer right-click the Tasks branch and select New Task.
o Alternatively, click Add in the Tasks editor.

The New Task dialog appears:

New Task f |
Create a new task /

Uris | ftestrestLri |
Component: | testCormponent | [Browse]
Caption: | testTask |
Context: | lindex/repository | [Browse]

Mame  Yalue

Task parameters;

\Wrap:

Requires Authentication: |:|

@ [ Finish ] [ Cancel

2 Input the following parameters:

Creating and Using Components



3

Parameter Definition

Uri Theidentifier for the task

Component Use Browse to select the component to associate with the task

Caption A name for the task

Context Use Browse to select the SOA Systinet context associated with the task. Context
specifies, for example, the content of the left menu.

Task Use Add and Remove to select parameters to use with the task

parameters

Wrap Select Wrap to contain the task output in the SOA Systinet Ul

Requires Select Requires Authentication if the task requires the user to log in before

Authentication

execution

Click Finish to create the task.

Developing the Component

When you create a component, as described in Creating a Component on page 79, the templates for the
Java class and JSP page are automatically created.

To view this code you must switch to the Java or the Debug perspective:
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Figure 8. Debug Per spective
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The project contains two source folders containing the Java and JSP files respectively.

Double-click the source file you want to edit to open an edit view enabling you to write your custom

component.

Debugging Your Code

Only changesto the Ul or the SDM configuration require the extension to be deployed to SOA Systinet.
After you deploy anavigation action that uses your custom component, you can edit your Javaand JSP and

the new functionality is applied to SOA Systinet directly.

Creating and Using Components

83



To start SOA Systinet from Customization Editor:
1 Inthe Run menu, select Debug to open the Debug diaog.

2 Select your server deployment under Generic Servers, and then click Debug to start the server in
debug mode.

The Console view displays the progress of the server start.
When the server is started the Server view displays your server with status Debugging.

Make changes to your Java and JSP as required and these changes are applied to SOA Systinet without the
need to reapply the extension of restart the server.

Example: Adding a Component to the Tools Menu
In this example, you add a new component, to T ools menu in the SOA Systinet Ul.

Figure9. Default Tools Menu View Section

Search

= Search for ... !m

View

I

I

Business Services

Tasks

Registries

Generate WSIL Document

Business Service

To follow this example requires the following prerequisites:

» Create anew extension dependent on the core extension with Develop JSPs selected, as described in
Creating an Extension Project on page 17.
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To createthe new component and add it to the tools menu:

1 Create acomponent as described in Creating a Component on page 79 using the following inputs:

Par ameter Input

Name testComponent

Page [test/testComponent.jsp
Class name test. TestComponent

2  Create atask as described in Creating a Task on page 81 using the following inputs:

Parameter Input

Uri [test/testUri

Component testComponent

Caption testTask

Context /index/repository

Wrap Selected

Requires Authentication Select if you want the user to sign-in to use the component

3 Createanavigation action asdescribed in Creating aNavigation Action on page 68 using thefollowing

inputs:
Parameter Input
Action ID testNavAction
Task Location ltest/testUri

4 Add the navigation action to the Tools tab as described in Adding Navigation Actions to an SOA
Systinet Tab on page 66. Select Item and use the following inputs:
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Parameter Input

Item Name testNavltem
Action ID testNavAction
Group Name View

Create your Java class and JSP as described in Devel oping the Component on page 82 adding the

following code:

Editor

Input

TestComponent.java

public void process(String arg0, Map argl) {

getRequest().setAttribute("test”, "created and deployed your test

component."); }

testComponent.jsp

Y ou have succesfully <c:out value="%{ test} "/>

Apply the extension as described in Direct Deployment to SOA Systinet on page 96.

Start the SOA Systinet server as described in Debugging Y our Code on page 83.

After you deploy this customization, the View section T ools menu includes the new navigation action.

86

Chapter 5



Figure 10. Customized Tools Menu View Section
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Click testNavl tem to execute the task.
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6 Moditying Taxonomies

The Customization Editor controls which taxonomies are available in the extension project. Y ou can create
and modify taxonomies using HP SOA Systinet Taxonomy Editor.

To control taxonomiesin your extension project:
1 Inthe Extension Explorer double-click Taxonomiesto open the Taxonomies editor.
2 To modify the available taxonomies in your extension project:
e Toimport taxonomies from SOA Systinet and add them to the extension click Import.
e To update taxonomies in your extension newer versions from SOA Systinet click Update.

* Toremove ataxonomy from the extension, select the taxonomy and click Remove.

» To enabletheimport or update of taxonomiesfrom SOA Systinet you must specify the correct
server URL during configuration (see Creating an Extension Project on page 17).
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/ Deploying an Extension to SOA
Systinet

Deploying an extension to SOA Systinet is athree-part process:

1 Saveyour new extension project as ajar filein the SOA Systinet extension folder as described in
Exporting the Extension Project on page 91.

2 Deploy the extension to SOA Systinet using the Setup Tool as described in Applying Extensions on
page 92.

3 Redeploy the EAR file to your application server as described in Redeploying the EAR to JBoss on
page 95.

Alternatively, if you are devel oping components in Customization Editor, you can directly deploy the
extension from Customization Editor as described in Direct Deployment to SOA Systinet on page 96.

Exporting the Extension Project

Customization Editor displays the entire configuration of your extension plus other extensions it depends
on. However, your extension only consists of any modifications and additions that you have made. Only
these changes are stored when you save your project as an extension jar file and only these changes are
deployed to SOA Systinet

To createyour extension package:

1 Right-click the extension name in the Extension Explorer (see Navigating the Customization Editor
on page 21 and select Build Extension to open the export dialog.

2 By default, the Extension Folder set during configuration (see Creating an Extension Project on page
17) is selected. Choose a save location and file name and click Save.
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Applying Extensions

SOA Systinet can be extended with librariesthat are added into the deployed .ear files. The setup tool opens
the .ear files, applies the extensions and repacks the .ear files.

Extensions to SOA Systinet come from the following sources:
e TheHP SOA Systinet Customization Editor

» HP SOA Systinet Policy Manager extensions used to create assertions in HP SOA Systinet Assertion
Editor. These extensions are custom validation handlers. Y ou must apply them to the Policy Manager
server in order for Policy Manager to use assertions created with them.

» Upgrading from the Visibility Edition to the Standard Edition, which requires Policy Manager and
Contract Manager extensions to be added to SOA Systinet.

Apply extensions according to one of the following scenarios:

* Single-step (default) — In this scenario, the setup tool performs all the processesinvolved in applying
extensions, including database aterations, as a single, seamless step.

» Decoupled Database — In this scenario, database SQL scripts are run manually, and the setup tool
performs the other processes as individual steps that are executable on demand. Thisisuseful in
organi zations where the user who applies extensions does not have the right to alter the database, which
is done by a database administrator.

Single-Step Scenario

Follow this scenario if you have permission to alter the database used for SOA Systinet.
To apply extensionsto SOA Systinet in a single step:
1 Ensurethat all extensions are in the PLATFORM HOME/ ext ensi ons  directory. The setup tool automatically

applies all extensionsin that directory.

» Note: If you are applying extensions to another server, substitute PLATFORM HOVE with the
relevant home directory.
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2  Stoptheserver.

3 Start the setup tool by executing PLATFORM _HOM E/bin/setup.bat(sh).

» Important: The application server to which SOA Systinet is deployed must not be running.

4 Select the Apply Extensions scenario and click Next. The setup tool automatically validates the step
by connecting to the server, copying the extensions and merging the SDM configuration.

5  Click Next for each of the validation steps and the setup execution. Note that this takes some time.
6 Click Finish to end the process.

7 For JBoss implementations the EAR file id deployed automatically. For WebL ogic and WebSphere,
redeploy the EAR file as described in;

e For WebL ogic follow the procedure described in the Deploying SOA Systinet Components section
of the HP SOA Systinet Installation Guide.

» For WebSphere follow the procedure described in the Deploying the SSO Service and Creating
EAR Files section of the HP SOA Systinet Installation Guide.

8  Restart the server.

Decoupled DB Scenario
Follow this scenario if the user who applies extensions does not also modify the database.
To apply extensions and modify the database separ ately:

1 Ensurethat all extensions are in the PLATFORM HOME/ ext ensi ons  directory. The setup tool automatically
applies all extensionsin that directory.
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» Note: If you are applying extensions to another server, substitute PLATFORV HOVE with the
relevant home directory.
Stop the server.

Start the setup tool by executing PLATFORM _HOM E/bin/setup.bat(sh).

» Important: The application server to which SOA Systinet is deployed must not be running.

Select the Advanced scenario and click Next.
Select the following steps:

e Extensions environment setup

* Extensions model execution

e Extensions database prepare

e Extensions database backup

Click Next, execute the chosen steps, and exit the setup tool.

The database administrator runsthefollowing SQL scripts. INSTALL_HOME refersto theinstallation
directory of the SOA Systinet component to which you are applying the extensions. The SQL scripts
must berun in thisorder:

a INSTALL_HOME\conf\sgl\dbschema_ Y OUR-DATABASE_drop.sql

b INSTALL_HOME\Wworking\sdm-gen\build\rdbms\sgl\dbschema Y OUR-DATABASE create.sq|

» Note: For DB2, the token & 1 must be replaced by the tablespace name.
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¢ INSTALL_HOME\working\sdm-gen\build\rdbms\sgl\dbschema_Y OUR-DATABASE insert.sql

8  Start the setup tool by executing PLATFORM_HOM E/bin/setup.bat(sh).

» Important: The application server to which SOA Systinet is deployed must not be running.

9  Select the Advanced scenario and click Next.
10 Select the following steps:

e Extensions database SQL sync

* Extensions database restore

* Extensions nonmodel execution

» Extensions environment finalize

* Client package crestion

11 Click Next, execute the chosen steps, and exit the setup tool.

12 For WebL ogic and WebSphere, deploy the new EAR filein the | NSTALL_HOVE\ depl oy directory.

Redeploying the EAR to JBoss

After using the setup tool to apply extensions or updatesit is necessary to redeploy the EAR fileto the
application server. For JBoss this can be done using the setup tool.

) 2 For WebL ogic and WebSphere follow the procedures described in the Deploying SOA Systinet
Components sections of the HP SOA Systinet Installation Guide.
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Toredeploy the EAR to JBoss:
1 Stop the application server.

2 Start the setup tool by executing PLATFORM _HOM E/bin/setup.bat(sh).

» Important: The application server to which SOA Systinet is deployed must not be running.

3 Choose the Advanced scenario and click Next.

4 Select Deployment, and then click Next.

5  When the setup tool validates the existence of the JBoss Deployment folder, click Next.
6  Click Finish to close the setup tool.

7 Restart the application server.
Direct Deployment to SOA Systinet
If you are creating components in Customization Editor it is not convenient to continually build and apply

extensions to SOA Systinet. Customization Editor enables you to deploy your extension directly to SOA
Systinet.

) 2 Only SOA Systinet deployed to a JBoss application server is supported by thisrelease.

Todirectly deploy an extension from Customization Editor:
1 Stop the application server.
2 Switch to the Debug perspective in Customization Editor.

3 Select Run->External Tools->External Tools from the menu to open the External Tools dialog.
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4 Select Ant Build->Customization Editor - Apply Extension.
5  Click Run to apply the extension.

The Console view displays the output of the deployment process.

Deploying an Extension to SOA
Systinet
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8 User Interface Reference

Each Customization Editor view in the main and bottom-right section of the editor is described in the
following sections:

Artifact Editor on page 100. Manage your SOA artifacts and customize their properties, appearance and
registry mapping.

Property Editor on page 111. Manage your SOA properties and which perspectives can seeand edit them.
Property Group Editor on page 115. Organize your properties into groups.

Navigation Editor on page 116. Customize the left-menu navigation links in SOA Systinet tabs.
Portlets Editor on page 118. Customize which portlets appear in SOA Systinet tabs.

Components Editor on page 120. Manage the componentsin SOA Systinet.

Contextual Action Groups Editor on page 121. Organize your context actions into groups.

Contextual Actions Editor on page 122. Manage the context actions available in the SOA Systinet Ul.
Navigation Actions Editor on page 124. Manage the navigation links available in SOA Systinet.
Portlets Definitions Editor on page 126. Manage the portlets available in SOA Systinet.

Tasks Editor on page 127. Manage tasksin SOA Systinet.

Perspectives Editor on page 125. Customize the perspectives available in SOA Systinet.

Taxonomies Editor on page 129. Customize the taxonomies available in SOA Systinet.

project.xml Editor on page 130. Manage your extension project.

Messages View on page 133. View the action log as you customize your extension project.
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e Search View on page 134. View the results of usage and entity searches.

Artifact Editor

Artifacts are the basic building blocks of SOA and represent all types of entity. This editor allows you to
modify the parameters, properties and appearance of an artifact type within SOA Systinet. Each artifact
type and package has an editor with the artifact name as the title containing five tabs described in the
following sections:

e Artifact — General Tab on page 100 . The main attributes of the artifact type
e Artifact — Properties Tab on page 102 . The properties of the artifact type

* Artifact — Service Catalog Ul Tab on page 104 . The format of the View Artifact page in the SOA
Systinet Ul

e Artifact — Tools Ul Tab on page 107 . The format of the View Artifact and Browse Artifact pagesin
the SOA Systinet Ul

» Artifact — Registry Mapping Tab on page 109 . The mapping of the artifact to registry entities
Artitact — General Tab

The General tab displays the general attributes of the artifact and allows you to modify some of them:
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Figure 11. Business Service Editor — General Tab

General

Artifact General Information

URI: urnicom:isystinet:soa:model: artif acts:soa:businessService
Display Mame: 3u5iness Service
Local Name: businessServicedrtifact

iZollection Display Mame: | Business Services
Package: 508
Extends Type:

Serwice described in business terms that can be implemented using one of maore Web Services or ather Implementations.
Contracts enable re-use of Business Services

Description:

Deprecated: O

Abstract:
Yisible to: Editable by:

*all* *al*
Properties User Interface

iZustomize properties of this artifact by Configure the appearance of artifact properties

editing properties and property groups and contextual actions in the user interface
Properties spedific For this artifact (4) Service catalog user inkerface enabled

Property aroups specific For this artifact (5) Tools user interface

Properties inherited from the superartifacts (0}

General | Properties | Service Catalog UL | Tools I | Registry Mapping

The general tab contains the following segments:

» Artifact General Information. The following parameters related to artifacts shown in this segment.
They are described in the table below:

Parameter Definition

URI Theidentifier for the artifact descriptor in the configuration
Display Name The name of the artifact as it appearsin the SOA Systinet Ul

Local Name The name of the artifact asit is stored in the extension

Collection Display | The plura version of the name as it appears in the SOA Systinet Ul
Name
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Parameter Definition

Package The parent artifact type that this artifact type belongs to

Extends Type The artifact type that this artifact type inherits the properties of

Description The description of the artifact type as it appearsin the SOA Systinet Ul
Deprecated A checkbox indicating whether the artifact is currently active in the extension
Abstract A checkbox indicating whether the artifact is an artifact package which does not

have actual instances in the repository

e Visbleto. A simplelist of perspectiveswith Add and Remove functionality to select which perspectives
can seethis artifact type within SOA Systinet.

o Editableby. A simplelist of perspectiveswith Add and Remove functionality to select which
perspectives can amend this artifact type within SOA Systinet.

» Properties. A summary of the different properties that the artifact has. Each of the links opensthe
Propertiestab described in Artifact — Properties Tab on page 102.

e User Interface. A pair of linksto the Service Catalog Ul and Tools Ul tabs where the appearance of
the artifact in the SOA Systinet Ul can be amended.

Artifact — Properties Tab

The Propertiestab displays al the properties of the artifact and enables you to add and remove them:
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Figure 12. Business Service Editor — Properties Tab

=8
-~
~ Properties
MName Cardinality ~ Extension Mew ...
[5UDDI Definition  multiple company
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[5 Implementation  multiple company
~ Property Groups
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= [ Model Properties company
= Contract Properties company
= Contract Consumer Properties company
B System Properties company
[& service Properties company
= Inherited Groups And Properties
Mame  Cardinality  Extension
v
General | Properties | Service Catalog UL | Tools UT | Registry Mapping

Thistab contains the following segments:
e Properties. Thisisthelist of individual properties of the artifact. On theright are the following buttons:
¢ New opensthe New Property dialog described in Creating a Property on page 51.

e Add adds a property to the artifact type from the list of available property descriptors, set its
cardinality, and itslocation on the View Artifact page.

e Deprecate deactivates the property in the artifact type.
« Undeprecate reactivates the property in the artifact type.

* Remove removes the selected property from the artifact type.
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» Property Groups. Thisisthelist of the property groups of the artifact. On the right are the following
buttons:

* New opensthe New Property Group dialog described in Creating a Property Group on page 60
e Add adds a property group to the artifact type from the list of available property groups.
¢ Remove removes the selected property group from the artifact type.
e Inherited Groupsand Properties. If the artifact is based on another artifact then this segment displays
the inherited artifact and its properties and groups.

The following property parameters are displayed in these segments:

Parameter Definition
Name The name of the property asit appearsin the SOA Systinet Ul
Cardinality The occurrence of the property in an artifact with options:

e Optional. The property is not required to be populated
* Required. The property must be populated

» Multiple. The property can occur multiple times with different values

Extension Which extension this property is part of

Artifact — Service Catalog Ul Tab

The Service Catalog Ul tab displays al the attributes of the artifact as they appear in the Service View
page of the Service Catalog in SOA Systinet and allows them to be amended:
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Figure 13. Business Service Editor — Service Catalog Ul Tab
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General | Properties | Service Catalog UL | Tools UT | Registry Mapping

There is a checkbox to control whether the artifact is available within the Service Catalog and if thisis
checked there are two segments to control its appearance:

e Layout. Thisisthelist of elements and properties of the artifact as they appear in the Service View
pagein the Service Catalog. The elements are organized into groups that match the sub-headings on the
Service View page. On the right are the following buttons:

e Up movesthe element up in the Service View page.
* Down moves the element down in the Service View page.

e Add addsaproperty, component or layout group to the Service View page as described in Modifying
the Layout of the View Artifact Page on page 38.
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« Edit enablesyou to edit the name of a sub-heading group or the editable by and visible to attributes
of aproperty.

* Remove removes the element from the Service View page.

The following page element parameters are displayed in this segment:

Parameter Definition
Name The name of the page element as in appears in the SOA Systinet Ul
Type The type of page element with options:

» Property isaproperty of the artifact type
* Component isa SOA Systinet Ul component

» Relationship isarelationship property of the artifact type

Visibleto The perspectives that can see this page element
Editable by The perspectives that can edit this page element in SOA Systinet
Extension Which extension this property is part of

e Contextual Actions. These are the options that appear in the context action menus at the top of the
Service View page. On the right are the following buttons:

e Up movesthe action up in thelist.
*  Down moves the action down in thelist.

* Add adds a new context action to this artifact as described in Modifying the Contextual Actions of
an Artifact on page 41.

« Edit enablesyou to edit the context action with the same parameters as Add functionality.
* Remove removes the action from context action menus.

The following contextual action parameters related to properties are shown in this segment:
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Parameter

Definition

Display Name

The name of the action asit appears in the SOA Systinet Ul

Action

Contextual action identification in the extension

Visbleto

The perspectives that can see this action

Extension

Which extension this property is part of

Artifact — Tools Ul Tab

The Tools Ul tab displays al the attributes of the artifact asthey appear in the View Artifact and Browse
Artifact pagesin Toolsin SOA Systinet and allows them to be amended:

Figure 14. Business Service Editor — Tools Ul Tab
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The following segments control its appearance:

» Layout. Thisisthelist of elements and properties of the artifact as they appear in the View Artifact
pagein Tools. The elements are organized into groups that match the sub-headings onthe View Artifact
page. On the right are the following buttons:

e Up movesthe element up in the View Artifact page.
e Down moves the element down in the View Artifact page.

e Add addsaproperty, component or layout group to the View Artifact page asdescribed in Modifying
the Layout of the View Artifact Page on page 38.

« Edit enablesyou to edit the name of a sub-heading group or the editable by and visible to attributes
of aproperty.

* Remove removes the element from the View Artifact page.

The following page element parameters are displayed in this segment:

Parameter Definition
Name The name of the page element as in appears in the SOA Systinet Ul
Type The type of page element with options:

e Property isaproperty of the artifact type
e Component isa SOA Systinet Ul component

» Relationship isarelationship property of the artifact type

Visibleto The perspectives that can see this page element
Editable by The perspectives that can edit this page element in SOA Systinet
Extension Which extension this page element is part of

e Contextual Actions. These are the options that appear in context actions at the top of artifact pages. In
the Tools Ul tab there are two tabs in this segment. Artifact Detail shows the actions for the View
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Artifact page and Collection shows the actions for the Browse Artifact page. On theright are the
following buttons:

e Up movestheaction up in thelist.
* Down movesthe action down in the list.

e Add adds anew context action to this artifact as described in Modifying the Contextual Actions of
an Artifact on page 41.

< Edit enables you to edit the context action with the same parameters as Add functionality.
¢ Remove removes the action from context action menus.

The following contextual action parameters are displayed in this segment:

Parameter Definition
Display Name The name of the action asit appears in the SOA Systinet Ul

Action Contextual action identification in the extension
Visibleto The perspectives that can see this action
Extension Which extension this context action is part of

Artifact — Registry Mapping Tab

The Registry M apping tab displays any mappings between the artifact and entitiesin registries and allows
you to create, edit and remove them:
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Figure 15. Business Service — Registry Mapping Tab
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It is split into the following segments:

» Artifact Mapping. Thisisthelist of registry entitiesthat represent the artifact in registries. On theright
are the following buttons:

e Add adds aregistry mapping as described in Mapping an Artifact Type to a Registry on page 43.
e Edit edits the mapping as described in Mapping an Artifact Type to a Registry on page 43.
¢ Remove removes the mapping from the artifact.

The following registry mapping parameters are displayed in this segment:

Par ameter Definition

Registry Name The registry that the artifact type is mapped to

TModel Key The taxonomy key used to categorize the UDDI entity in the registry

Key Name The name used to categorize the UDDI entity in the registry
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Parameter Definition
Key Value The value used to categorize the UDDI entity in the registry

Extension Which extension this mapping is part of

» Property Mappings. Thisisthelist of the properties of the artifact and if they are mapped to aregistry.
On theright are the following buttons:

* Add adds anew registry mapping for the selected property as described in Mapping an Artifact
Typeto aRegistry on page 43.

« Edit edits a property mapping as described in Mapping an Artifact Type to a Registry on page 43.
¢ Remove removes a mapping from the selected property.

The following registry mapping parameters are displayed in this segment:

Parameter Definition

Property Name The name of the property

Registry Name The registry that the artifact type property is mapped to

TModel Key The taxonomy key used to categorize the UDDI entity in the registry
Key Name The name used to categorize the UDDI entity in the registry
Extension Which extension this property is part of

Property Editor

Properties are attributes of artifacts. The property editor allowsyou to modify the propertiesin your extension
project. Each property has an editor with the property name asthetitle containing the following tabs described
in sections:

*  Property —General Tab on page 112. The main attributes of the property

e Property — Advanced Tab on page 113. The advanced attributes of the property
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Property — General Tab

The General tab displays the general attributes of the artifact and enables you to modify some of them:

Figure 16. Description Editor —General Tab

General

General

Display Mame: bescnptlon

Local Name: description

Description:

Collection Display Mame: | Description

Deprecated: O

Property Type

URI: urn:com: systinet: soa:madel:properties:description

Description of the artifact, what it is used for etc,

Propetty Type: textareaPropertyType
visible to:

*al*

General | Advanced

Editable by:

*all*

Thistab contains the following segments:

* General. Thefollowing property parameters are displayed in this segment:

Parameter Definition
Display Name The name of the property asit appears in the SOA Systinet Ul
Local Name The name of the property asit is stored in the extension
URI Theidentifier for the property descriptor in the configuration
Description The description of the property asit appearsin the SOA Systinet Ul
Collection Display | The plural version of the name as it appears in the SOA Systinet Ul
Name
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Parameter

Definition

Deprecated

A checkbox indicating whether the property is currently active in the extension

Property Type, Reationship, or Taxonomy. There are three types of property and this segment is
specific to each:

e Property Type. The property type for primitive properties.

* Relationship. This segment displays the source and target artifacts that this relationship links and
some parameters of theinverse relationship. On the right are two sets of two buttons for altering the
source and target artifacts:

e Add selects an artifact in the extension to source or target.

* Remove removes the relationship from a source or target artifact.

e Taxonomy. Thetaxonomy that containsthe available optionsfor this property with Browseto select
anew taxonomy from the extension project.

» Visibleto. A list of perspectiveswith Add and Remove functionality to select which perspectives can
see this property within SOA Systinet.

» Editable by. A simplelist of perspectives with Add and Remove functionality to select which
perspectives can amend this property within SOA Systinet.

Property — Advanced Tab

The Advanced tab displays the advanced attributes of the property and allows you to modify them:
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Figure 17. Description Editor Advanced Tab

FIEETEN =
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This tab contains the following segments:

e Multiple Cardinality:

Parameter Definition

MinOccurs If a property has multiple cardinality this parameter is the minimum occurrences of
the property in an artifact

MaxOccurs If aproperty has multiple cardinality this parameter is the maximum occurrences of
the property in an artifact. Use unbounded if there isno limit.

e Default Values:
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Parameter Definition
Default Value An XML extract defining the default value

Multiple Default | An XML extract defining default values in the case of multiple cardinality
Vaue

» Database Sizes displays optional database sizing for property elements with Add, Edit and Remove
functionality.

Property Group Editor

Properties can be organized into groups. The property group editor allows you to add and remove properties
from a property group. Each property group has an editor with the property group name as the title:

Figure 18. System Properties Editor
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[ 1dentifier Bag optional company

The editor contains the following collapsible segments:

e General enables you to change the Display Name and view the URI of the property group.
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e Properties enables you to manage the property group.

On theright are three buttons:

New creates a new property as described in Creating a Property Group on page 60.

Add adds a property to the group from the list of available properties.

Remove removes the sel ected property from this property group.

The following property parameters are displayed and described in the table below:

Parameter Definition
Name The name of the property
Cardinality The occurrence of the property in an artifact with options:
» Optional. The property is not required to be populated
* Required. The property must be populated
e Multiple. The property can occur multiple times with different values
Extension Which extension this property is part of

Navigation Editor

Navigation actions are the links between pages in SOA Systinet. The navigation editor allows you to
configure the left menu and title of SOA Systinet tabs:
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Figure 19. Dashboard Navigation Editor
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The editor contains the following collapsible segments:
* General enables you to change the Display Name and Description of the SOA Systinet tab.

* Menu enablesyou to configure theleft menu of the SOA Systinet tab. The navigation itemsare arranged
into headings and links.

On theright are the following buttons:

¢ Up movesthe selected item up in the menu.

*  Down moves the selected item down in the menu.
e Add contains the following options:

* Item adds anavigation item to the menu as described in Adding Navigation Actionsto an SOA
Systinet Tab on page 66.

» Component adds a component to the menu as described in Adding Components to a SOA
Systinet Tab on page 67.
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e Group adds a new heading to the menu as described in Adding Navigation Groups to a SOA
Systinet Tab on page 65.
» Edit opens one of the following edit dialogs depending on the item selected:

e |tem edits anavigation item with the same parameters described in Adding Navigation Actions
to an SOA Systinet Tab on page 66.

e Component edits acomponent with the same parameters described in Adding Components to
a SOA Systinet Tab on page 67.

*  Group editsamenu heading with the same parameters described in Adding Navigation Groups
to a SOA Systinet Tab on page 65.

* Remove removes the selected navigation item from the SOA Systinet tab menu.

This segment contains the following navigation action parameters:

Parameter Definition

Name The name of the navigation item as it is stored in the extension

Task Location Theidentification of SOA Systinet Ul task invoked by this menu item
Type Item or Component

Visibleto Which perspectives can see thisitem

Extension Which extension this navigation item is part of

Portlets Editor

There is a separate portlets editor for each tab within SOA Systinet. These allow you to control which
portlets are available in each tab and where they appear.
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Figure 20.
CEYEn.

Dashboard Portlets Editor
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Services page columnl  company

On theright are the following buttons:

* Add opensthe New Portlet Placement dialog described in Adding Portlets to a SOA Systinet Tab on

page 64.

» Edit opensthe Edit Portlet Placement dialog for the sel ected portlet with the same parameters described
in Adding Portletsto a SOA Systinet Tab on page 64.

* Remove removes the selected portlet from the SOA Systinet tab.

The following portlet placement parameters are displayed:

Parameter

Definition

Portlet Reference | Theidentification of the portlet in the extension

Name

Portlet Display The name of the portlet as it appears on the SOA Systinet tab

Location Name There are two options:

e page. Theportlet is open in the main area of the SOA Systinet tab

e menu. The portlet is closed but available to add in the left menu
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Parameter Definition

Area If the portlet is open this specifies which column it appearsin on the SOA Systinet
tab

Extension Which extension this portlet is part of

Components Editor

Components are functiona elements which can be added to the SOA Systinet Ul.

Figure 21. Components Editor
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B textareaComponent searchftextAreaComponent. jsp com, systinet, platform,ui.search, TextAreaComponent

B kestCamponent JftestftestCampanent. jsp kest, TestComponent

taxonomy Treehode taxonomies/taxonomy TreeNode. jsp

B taxonomyTreeComponent taxonomies,/taxonomy Tree. jsp com, systinet, webfw, taglib, registry tree, Taxonomy Tree

B ssolntersiteTransferService Issofits.jsp com. systinet . platform.ui.sso.Inkersite TransferService

sessionExpired sessionExpired. jsp

B selectableTaxonomyTreeBranch  taxonomies/selectablsTaxonomyTreeBranch.jsp  com,systinet.webFw,taglb registry.tree, SelectableTaxc

B selectableTaxonomyTree taxanomies/selectableTaxonomyTree. jsp com. systinet . webfuw, taglib. registry tree. Selectable Taxe

selectManyCompanent searchfselectMaryComponent . jsp com. systinet . platform.ui.search. SelectManyCompanent

B selectComponent searchfseleckComponent. jsp com, systinet, platform,ui.search, SelectComponent

B redirect redirect. jsp com, systinet, webfuw, component . RedirectComponent

B purgeConfirmation document/purgeConfirmation. jsp com. systinet platform,ui.document . PurgeConfirmation

B notices notices . jsp

B navigationPath navigationPath. jsp com. systinet, webfuw, component . NavigationPath

B main main. jsp com. systinet . webfw, component  MainComponent

B logout com, systinet webfw, component, LogoutComponent

B login login.jsp com. systinet, webfuw, component . LaginCompaonent

inputComponent searchfinputComponent. jsp com. systinet . platform,ui.search. InpubComponent

Bl home: home.jsp P

On theright are the following buttons:
*  New opens the New Component dialog as described in Creating a Component on page 79.

» Edit opensthe Edit Component dialog with the same parameters described in Creating a Component
on page 79.
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* Remove deletes the selected component from your extension project.

The following component parameters are displayed:

Parameter Definition
Name The name of the component asit is stored in the extension
Page The JSP that the component uses

Class Name The Java class the component uses

Extension Which extension this component is part of

Contextual Action Groups Editor

Context actions can be grouped in order to add many actionsto aUl element at once. The contextual action
groups editor allows you to create, edit and remove context action groups from your extension project:

Figure 22. Contextual Action Groups Editor

Contextual Action Groups X

Contextual Action Groups

Contextual Action Groups

Name
= B Common Actions (View - Commeon])
[% Revision History
[ Access Rights
[ ML view
[ R view
= @ Cammon Actions (Brawse - Common)
[ ML view
[ R view
[ Access Rights
= B Common Actions (View - Tools)
[ Related Reports
B Impact Management
[ Add Documentation
= iZommon Actions (Browse - Context Buttons)
e

Action 1D

revisionHistory

accessRights
=miView
resifiew

=miView

rssifiewBrowse

accessRights

associatedReportsExtension
impactCheckDocumentExtension
addDocumentation

[P

L

Visible To | Extension

*all*
*all*
*all*
*all*

*all*
*all*
*all*

*all*
*all*

*all*

T

company
company
company
company

company
company
company

company
company

company

& [oa)

On theright are the following buttons:

* Add contains the following options:
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e Action Item adds a context action to a group as described in Adding Context Actions to a Group
on page 73.

e Group of Contextual Actionsadds anew context action group as described in Creating a Context
Action Group on page 72.
e Edit hasthe following functions depending on which item in the editor is highlighted:
e For agroup you can edit the name.
» For anitem the Edit Item dialog with the same parameters as described in Creating a Contextual
Action on page 70.
» Remove deletes the selected context action item from your extension project.

The following contextual action group parameters are displayed:

Parameter Definition

Name The name of the action group asit is stored in the extension
Action The reference to the contextual action in the extension
Visibleto Which perspectives can see thisitem

Extension Which extension this perspective is part of

Contextual Actions Editor

Context actions are options available in the SOA Systinet Ul for artifact and service pages. The contextual
actions editor allows you to create, edit and remove context actions from your extension project:
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Figure 23. Contextual Actions Editor

=8
Contextual Actions =
Contextual Actions
Action ID Task Location Extension Newt ..,
fos\tnrt\factr\lew fcontextActions/browsellew company
& squery ToolartifactNew fronkextActionsfbrowseiiew company
& squeryArkifactMew frontextActionsibrowseMew company
[ srnlview JutilfrestLink. company
[5 smniServicedrtifactiew fronkextActionsfbrowseiiew company
[ xmischematrtiFacthev frontextActionsibrowseMew company
[5 wsdlverificationExtension fwebService/verification/verification company
i wsdlOperations fwehService/operations company
[ wsdlartiFacthev frontextActionsibrowseMew company
% wsPalicyArtif ackhew fcontextActions/browsellew company
[ webserviceartifartlew fronkextActionsfbrowseiiew company
[ webartiFactew frontextActionsibrowseMew company
% wigwUddiRegistry ArtifactUDDIINtegration fintegration/uddifuddiRegistryContextactions company
i wiew3erviceArtifactDDTIntegration finteqgration/uddifwebServiceContextactions company
& wigwReportData freportsfviewIndexReportDataContextAction company
% wigwOrganizationUnitartifactDDIIntegration  fintegration/uddi/organizationUnitContextactions  company
i wiewBusinessServiceArtifactUDDIINtegration  finkegration/uddifbusinessServiceContextactions  company
& wigwArtifactChangeManagement ftoolsfresourcehangeManagementExtension company
% uddiRegistryartifacthen fcontextActions/browsellew company
i uddiEntityartifactiiew fronkextActionsfbrowseiiew company
[ uddichannelartFacthev: frontextActionsibrowseMew company w

On theright are the following buttons:
* New opensthe New Action dialog described in Creating a Contextual Action on page 70.

» Edit opensthe Edit Action dialog with the same parameters as described in Creating a Contextual
Action on page 70.

* Remove deletes the selected context action from your extension project.

The following contextual action parameters are displayed:

Parameter Definition

Action ID The identification of the contextual action asit is stored in the extension
Task Location | Theidentification of SOA Systinet Ul task invoked by this contextual action
Extension Which extension this perspective is part of
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Navigation Actions Editor

Navigation actions are the links available in the menus of SOA Systinet tabs. The navigation actions editor
allowsyou to create, edit and remove navigation actions from your extension project:

Figure 24. Navigation Actions Editor

=0

Navigation Actions _
Navigation Actions

Action ID Task Location Extensian Mew ...

[ tools, vigwWSIL JutilfrestLink, company

[ toals.viewTasks ItoolsftaskartifactibrowseT askartifact company

[E= tools.viewRegistries JroolsjuddiftegistryArtif act browseUddiRegistryArtifact companty

[ tools.viewBS JtoolsibusinessServiceArtifactfbrowseBusiness ServiceArtifact compary

[ toals.registryContentImport Jlinkegrationfuddifimport company

[E= tools.recentDocuments Jbrowse recentlylsedArtifacts companty

[ tools.newwWebApplication Jtoolsfrebartifact/publish\Webartifack compary

[ tools.newTask ftoolsftaskartifactipublishTaskartifact company

B tools.newSOAPService JIpublishingjwebServiceFromwsd] companty

[ tools.newOther JfpublishingystructuredFile/wizard compary

[ tools.newHTTPService ItoolsfxmlserviceArtif act [publishxmlServiceartifact company

E= tools.newss JroolsjbusinessServicedrtifact fpublishBusinessserviceArtifact companty

[ tools.administrationUserPerspectives Iperspective/listPerspectives compary

[ toals. administr ationUserGroups JgroupfmenultemGroups company

[E= tools. administrationUseraccaunts JaccountfmenultemAccounts companty

[ tools.administrationServerConfiguration  Juserstorefserver-preferences compary

[ sm. todoList JsmytodaList company

B sm.newBs Iservices/businessserviceartifact/publishBusinessServiceartifact  comparry

[ sm.my3ervices Jemfleftmenu compary

[ sm.myPending Jsmyfleftrmenu company

B sm.myContracts Jsmfleftmenu companty o

On theright are the following buttons:
* New opensthe New Action dialog described in Creating a Navigation Action on page 68.

» Edit opensthe Edit Action dialog with the same parameters as described in Creating a Navigation
Action on page 68.

* Remove deletes the selected navigation action from your extension project.

The following navigation action parameters are displayed:
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Par ameter Definition

Action ID Theidentification of the navigation action asit is stored in the extension
Task Location | Theidentification of SOA Systinet Ul task invoked by this menu item
Extension Which extension this perspective is part of

Perspectives Editor

Perspectives are the way SOA Systinet controls what users can view. The perspectives editor allows you
to create, edit and remove perspectives from your extension project:

Figure 25. Per spectives Editor
Ormae. -

Perspectives

Perspectives

MName Display name Description  Extension Mew ...
& iservicePublisher  Service Publisher comparey

& general General compary

& administr ator Administrator Company

& Guest Guesk cormpany

On theright are the following buttons:
* New opensthe New Per spective dialog described in Creating a Perspective on page 74.

» Edit opensthe Edit Per spective dialog for the sel ected perspective with the same parameters described
in Creating a Perspective on page 74.

* Remove deletes the perspective from your extension project.

The following perspective parameters are displayed:

Parameter Definition
Name The name of the perspective asit is stored in the extension
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Parameter Definition

Display Name | The name of the perspective asit appears in the SOA Systinet Ul

Description The description of the perspective as it appears in the SOA Systinet Ul

Extension Which extension this perspective is part of

Portlets Definitions Editor

Portlets are the componentsthat appear in the main areaof SOA Systinet tabs. The portlets definitions editor
allows you to add, edit and remove portlet definitions from your extension project:

Figure 26. Portlets Definitions Editor

= Portlets Definitions X =B
Portlets Definitions
Portlets Definitions
Portlet IC Type LRI Partner Extension New ...
B wsdls feed  rest/repositoryfwsdlsi?rss @platform, sso.identity.id  company
= webServices feed rest{repositoryjservicedrtifacks/?res @platform ssouidentity,id - company
& reporting partlet  freportsftasksandReparts company
& reportLauncher portlet  JreportsireportLauncher Company
= organizationUnits feed rest/repositoryjcontact Artif actsiPrestacs _artifac,,,  @platform,ssoiidentity id  company
& informationManager portlet  jtoolsfindexjcallection-browse company
B documentation feed  rest/repository/documentation)rss @platform, sso.identity.id  company
= businessServicesz  feed rest{repositoryjbusinessServiceArtifacks/?rss @platform ssouidentity,id - company
B businessservices feed rest /repository/businessServiceArtifacks/trss @platform. sso.identity.id  company

On theright are the following buttons:

* Add containsthe following options:
* Feed adds anew RSS feed portlet as described in Creating an RSS Feed Portlet on page 76.
e Portlet adds anew portlet as described in Creating a Portlet on page 75.

» Edit opensthe Edit Feed or Edit Portlet dialog for the selected item with the same parameters as Add
functionality.
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¢ Remove deletes the selected portlet from your extension project.

The following portlet parameters are displayed and described in the table below:

Parameter Definition
Name The name of the portlet asit is stored in the extension
Type The type of portlet with options:

* Feed

* Portlet
URI Theidentifier for the portlet descriptor in the configuration
Partner The SSO partner identification
Extension Which extension this perspective is part of

Tasks Editor

Tasks aretop level SOA Systinet Ul components accessible viatheir uris. The tasks editor allows you to
create, edit and remove tasks from your extension project.
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Figure 27. Tasks Editor

Tasks =
Tasks

Uri Component Caption | Extension Mew v,

& ifwidgetsfbinary-datafeditorAttachmentUpload widgetsibinary-datafeditorattachmentUpload test :

B fwidgetsibinary-datafeditor [fwidgetsfbinary-datafeditaor test

& fwebService verificationjverificationResult JwebService)verification)verificationResult test

& fwebServicefoperationDetail [webService/operationDetail test

B fviewacl acliewComponent test

& utilinoPermission JutilfnoPermission test

@ fuserstorefuser-preferences Juserstorejuser-preferences test

Bl Juserstorefserver-preferences [userstore/server-preferences test

& fundeleteConfirmation undeleteConfirmation test

& ftoolsfeollectionlpdatewizard [toals/callectionUpdatewizard test

B frestjtestUri testComponent testTask test

& fssofits ssolntersiteTransferService test

& fsmiwsdlUploadwizard IsmywsdiUploadivizard test

{8 JsmjupdateDocumentation [smjupdateDocumentation test

& fsmjrepublishizard [smjrepublishiizard test

& fsmfoneaction [smjonedction test

B JsmnoPermissionSc [sminoPermissionsC test

& fsm/listRejectedrequestsOFaservice JcmysimplelList test

& fsmflistRecentUpdates JemysimpleList test

B Jsm/listPendingRequestsofaservice JemysimpleList test

B fsmilisthiyServices JcmysimplelList test P
< >

On theright are the following buttons:

* New opensthe New Task dialog described in Creating a Task on page 81.

» Edit opensthe Edit Task dialog with the same parameters described in Creating a Task on page 81.

* Remove deletes the selected task from your extension project.

There are the following parameters related to tasks:

Parameter Definition
Uri Theidentifier for the task
Component The component the task uses

Caption

A name for the task

Extension

Which extension thistask is part of
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Taxonomies Editor

Taxonomies are category groups that allow you to organize your services. The taxonomies editor allows

the import and removal of taxonomies from your extension project:

Figure 28. Taxonomies Editor

=0
. -~
Taxonomies
Taxonomies
Narne THadel Key Extension
dema:department 1D uddi:systinet.com:demo:departmentid companty
demo:hierarchy uddiisystinet,com:demo:hierarchy company
demo: location:Floar uddi:systinet.com:dema:location: floar company
dnb-com:D-L-N-5 uddi:uddi.org:ubr :identifier:dnb. com:d-u-n-s companty
iicati uddi ifications company
7 oo 3043 0c Compart:
compary
ntis-govinaics: 2002 uddi;uddi,org:ubr: categorization: naics: 2002 company
ntis-gow:sic: 1997 uddi: 70580F61-77hc-4621- 852 2-2a406acc35dd company
systinet-com:acl uddi:systinet.com:acl companty
systinet-com:aclicreate-allowed uddizsystinet,com: acl: create-allowed company
systinet-com:ac:create-denied uddi:systinet.com: acl: create-denied company
systinet-com:acl:delete-alowed uddi:systinet.com:acl: delete-allowed companty
systinet-com:acl:delete-denied uddiisystinet,com: acl: delete-denied company
systinet-conm: acl:find-allowed uddi:systinet.com: acl:find-allowed company
systinet-com:acl:find-denied uddi:systinet.com:acl:find-denied companty ~

On theright are the following buttons:

e Import imports taxonomies from the active SOA Systinet server.

» Note: The referenced SOA Systinet server must be running during import.

* Update refreshes the taxonomy list with any changes from the SOA Systinet server.

* Remove deletes the selected taxonomy from the extension project.

There are the following parameters related to taxonomies described in the table below:

Parameter

Definition

Name

The name of the taxonomy asit is stored in the extension

User Interface Reference
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Parameter Definition

TModel Key The taxonomy key identifier

Extension Which extension this taxonomy is part of

project.xml Editor

The project editor allows you to configure your extension project. It contains three tabs described in the

following sections:
» Project —Overview Tab on page 130
e Project — Environment Tab on page 131

» Project — Dependencies Tab on page 133

Project — Overview Tab

The Overview tab enables you to view and amend the basic parameters of your extension project:

Figure 29. Project Overview Tab

E project.xml X

Overview

~ Project details

Project name:  com,systinet.soa.ext, company

Project bype: Extension project

Project location: CiiDocuments and Settingsiplattiworkspacelcom. systinet.soa.ext. company
Last modified:  Tue, 1 May 2007 11:15:31 aM

~ Extension details

Marne: | COMPany

Versian: | 1.0

Descripkion: | Campany Specific

URI: com, systinet, 504, ext. company

Mamespace: | com. systinet, s0a, ext.company

Cverview | Environment | Dependencies

The tab contains the following collapsible segments:
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e Project details displays parameters for the extension project:

Parameter Definition

Project name The name of the extension project

Project type The project is an extension project

Project location The workspace folder that contains the extension project
Last modified The last time the project was changed

» Extension details enables you to configure some of the extension project parameters:

Parameter Definition

Name The display name of the extension

Version The version number of the extension project

Description A description of the extension project

URI Theidentifier for the extension in the configuration (not editable)
Namespace The prefix used for the URI when you create a new artifact type or property

Project — Environment Tab

The Environment tab displays the parameters of the SOA Systinet server that the Customization Editor is

configured for:

User Interface Reference
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Figure 30. Project Environment Tab

E projectxml X =0

Platform Environment

= Platform environment

Flatform Home: ChHewlett-PackardySystinetFlatform
Extension folder: CHewlett-Pack ardiSystnetFlatfor mexensions
Server URL: b fAocahost B0B0 08

Develop 15Ps:

JBoss Deploy Directory: 3 JBoss Platformiserveridefaultideplory
JBoss INOI Port: 1092

Overview | Ervironment | Dependencies

Thistab contains parameters:

Parameter Definition

Platform Home Your SOA Systinet installation folder

Extension Folder | Thelocation of the extension folder in your SOA Systinet installation

Server URL The URL used to access SOA Systinet

Deploy JSPs Indicatesif component and JSP devel opment is configured for your extension project
JBoss Deploy Deployment directory for your JBoss application server

Directory

JBoss JNDI Port | INDI port configured in your JBoss application server
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Project — Dependencies Tab

The Dependencies tab displays general information about your extension project and any dependencies
that is has:

Figure 31. Project Dependencies Tab

B project.xml X -8

Dependencies

Extension dependencies Project and extension general information

Hieratchical view of required extensions: Propetties of the selected extension

Marne: company

Wersian: 1.0

Description: Compary Specific

URI: com,systinet, soa, ext.company
Buildtime:  Fri Apr 27 15:45:00 CEST 2007

Crwverview | Environment | Dependencies

The tab contains the following segments:
» Extension dependencies displays atree of extensions that the extension project is dependent on.

e Project and extension general information displays parameters of the extension project:

Parameter Definition

Name The name of the extension

Version The version number of the extension project

Description A description of the extension project

URI Theidentifier for the extension project in the configuration (not editable)
Buildtime The creation date and time of the extension

Messages View

The M essages view tracks the changes that you make to extension entities and displays any warnings and
problems that may occur as aresult of those actions:
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Figure 32. Messages View

Action
=[] Delete Property [Tue May 01 12:52:59 CEST 2007]
® Froperty Definition of cannot be removed becauss it is used in artifa

Cause

L' B Artifact T
ition' is contained in artifac [& Artifact P
@ 1t is nat allowed ta remave property ‘Definition of' as inverse property ‘Definition’ is contained in artifac [ Artifact Type 'SOAP Service'
@ Itis not allowed to remove property ‘Definition of' as imverse property ‘Definition’ is contained in artifac [ Artifact Type HTTP Service'
] Delete Property [Tue May 01 12:52:55 CEST 2007]
Save Artifact Type [Tue May 01 12:52:43 CEST 2007] [E Artifack Type ‘Business Services'

@ Itis not allowed ko remave property 'Definition of' as inverse property

Double-clicking an item in the tree opens the relevant editor for that object.

Search View

The Sear ch view displays the results of a search (see Searching the Extension on page 28) or find usage
guery (see SDM Details on page 24):

Figure 33. Search View

O 4| X% BE|YEF-=2770

Seatch results For 'contract’ (30 matches)
= Eﬂ Artifact Types

B Request
[ Usage Plan

[@ Property Descriptors

=B Property Groups

B Contract Consumer Properties
& contract Propetties

Theresults are shown as atree of artifact types, properties and property groups containing the requested
item.

Double-clicking an artifact type, property or group opens the relevant editor.
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